The following disclaimer is required by 3Prong.com Inc.:  
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:  
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DeveloperMentor

This product may include the JCifs library, for which the following notice applies:  
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or “commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks


Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks contained herein are the property of their respective owners.
Footage

Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved.
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines.
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada.
Saturn “Calvin Egg” — Courtesy of Cossette Communications.
“The Big Swell” — Courtesy of Swell Pictures, Inc.
Windhorse — Courtesy of Paul Wagner Productions.
Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc.,
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornadoes + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.

Avid File-Based Workflows Guide • July 2013
Contents

Chapter 1  
Digital Cinema and TV Productions  ................................................. 11

  Workflow: Digital Cinema & Scripted TV Productions.  .................... 12
    Dailies Creation ........................................................................ 13
  Acquisition of High-Resolution Media. ............................................ 14
  Acquisition to Shared Storage ..................................................... 14
  Linking to File-Based Media ..................................................... 15
  Audio Editing & Mixing ............................................................. 15
  Finishing & Special Effects ...................................................... 16
  Output and Distribution ............................................................ 16

  Workflow: Unscripted TV Production ........................................... 17
    Acquisition of High-Resolution Media. ......................................... 18
    Acquisition via Video Server .................................................... 19
    Acquisition to Shared Storage .................................................. 19
    Linking to File-Based Media ................................................... 20
    Audio Editing & Mixing ......................................................... 20
    Finishing & Special Effects .................................................... 21
    Output and Distribution ......................................................... 21

  Editing on Interplay ...................................................................... 22

  Checklist: File-Based Editing Workflow ....................................... 25

  Considerations when Editing with File-Based Media ................... 30

  Organizing your File-Based Media ............................................. 34

  Embedding Metadata in your Clips ............................................ 35
    Preparing your File-based Clips for Downstream Processes ............. 36
    Metadata for Relinking Processes ......................................... 38
    Metadata for AAF Interchange ............................................... 39
    Metadata for EDL Interchange ............................................... 40
    Metadata Interchange for Applications using Avid Media Toolkit (AMT) 41

Chapter 2  
Working with High-Resolution Media .............................................. 43

  What's the Difference between Resolution and Size? .................... 45
Chapter 3 Acquisition of File-Based Media (AMA) 

The Avid Media Access (AMA) Workflow 79

Considerations and Limitations for AMA 82

Viewing Installed AMA Plug-ins 83

Selecting the AMA Settings 83

Manually Copying File-Based Media to a FireWire or Network Drive 85

Dragging and Dropping File-based Media Directly to a Bin 85

Creating Dynamic Media Folders 86

Linking Media with AMA 93

Relinking to AMA-Linked QuickTime Files 97

Spanned Clips 98

AMA Linking with Ancillary Data 99

AMA Linking with Multichannel Audio 99

The AMA Plug-in Log File 102

Using Virtual Volumes 102
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Volumes and AMA Bins</td>
<td>103</td>
</tr>
<tr>
<td>Deleting Clips</td>
<td>103</td>
</tr>
<tr>
<td>Using AMA Plug-Ins</td>
<td>104</td>
</tr>
<tr>
<td>Using XDCAM and XDCAM EX and XDCAM SR AMA Plug-Ins</td>
<td>104</td>
</tr>
<tr>
<td>Using XDCAM Multiple Resolution Clips with AMA</td>
<td>106</td>
</tr>
<tr>
<td>Using the P2 AMA Plug-In</td>
<td>110</td>
</tr>
<tr>
<td>Using the AVCHD AMA Plug-In</td>
<td>112</td>
</tr>
<tr>
<td>Using the Canon XF AMA Plug-In</td>
<td>114</td>
</tr>
<tr>
<td>Using the GFCAM AMA Plug-In</td>
<td>115</td>
</tr>
<tr>
<td>Using the RED AMA Plug-In</td>
<td>117</td>
</tr>
<tr>
<td>Using the QuickTime AMA Plug-In</td>
<td>125</td>
</tr>
<tr>
<td>Using the MXF AMA Plug-In</td>
<td>131</td>
</tr>
<tr>
<td>Workflow for Editing Clips with Ancillary Data and AMA</td>
<td>132</td>
</tr>
<tr>
<td>Understanding the Source Settings Histogram</td>
<td>133</td>
</tr>
<tr>
<td>Adjusting the Source Settings Histogram</td>
<td>135</td>
</tr>
<tr>
<td>Working with Export Volumes</td>
<td>136</td>
</tr>
<tr>
<td>Creating an Export Volume</td>
<td>137</td>
</tr>
<tr>
<td>Moving Assets to an Export Volume</td>
<td>139</td>
</tr>
<tr>
<td>Committing Assets to an Export Volume</td>
<td>140</td>
</tr>
<tr>
<td>Archiving the AS-02 Bundle</td>
<td>141</td>
</tr>
<tr>
<td>Linking to an existing AS-02 Bundle</td>
<td>141</td>
</tr>
<tr>
<td>AS-11 Support</td>
<td>142</td>
</tr>
</tbody>
</table>
Digital Cinema and TV Productions

Production companies, post houses, and audio post facilities need to stay connected and in constant contact to meet tight deadlines and stringent quality requirements. Offline editing, sound post, effects and graphics work can take place at different facilities, and Avid editing tools and interconnectivity solutions support the file interchange workflows between these specialized post facilities.

Modern advances in cinematography, like the digital cameras from RED, Arri, and Sony, have changed the media-creation industry. The new generation of video cameras records to digital media instead of film or videotape. This allows editors to copy the file-based media directly onto the editing system. As a result, productions can now be edited from start to end using a tapeless format.

File-based workflows can greatly accelerate post-production, replacing real-time tape capture with much faster file-based import along with the integral metadata to preserve image quality throughout the editing pipeline. With the emergence of new digital cameras that can record images with higher precision and dynamic range, media can come in varying size, resolution, aspect ratio, frame rate, compression, and color encoding (color model, bit depth, gamma). Avid applications have adapted to allow better handling of resolutions and color encoding that these cameras and formats are constantly introducing.

You now have a reliable approach to achieve accurate and consistent color throughout your workflow. The editing application will ease the editing of high-resolution images and properly manage the colors in these images right through the production pipeline. The metadata associated with the files ensures that the original information is represented as accurately as possible, and enables other downstream systems and processes to reproduce the same look for final delivery to cinema, HD, SD or web formats. The source file metadata is transferred via Avid’s AAF to exchange color and spatial information with partner products, and ensure that the media can be re-linked within the Avid and partner eco-systems.

Media Composer’s first step towards resolution independence allows you to link directly to the high-resolution footage (2K and higher), and apply the necessary color transformations and image framing options, all within an HD/SD project. For example, you can perform your editorial within an HD frame size, and still pan over the high-resolution image to keep the important action within view.
While performing the edit, you can perform a background transcode of the media used in your sequence so that you can continue the editorial with a lower proxy resolution, but with improved playback and performance for VFX layers. For the finishing, you can then relink back to the high-resolution footage for the final conform, finishing, render and output to HD, SD or other delivery formats.

The scenarios presented in this document provide recommendations for file-based workflows using Avid products.

- Digital Cinema (2K+ documentary or movie productions) and Scripted TV (series, soap operas, commercials)
- Unscripted TV (reality, talk, or lifestyle TV shows)

Refer to the following topics before you start editing your media:

- **Workflow: Digital Cinema & Scripted TV Productions**
- **Workflow: Unscripted TV Production**
- **Editing on Interplay**
- **Considerations when Editing with File-Based Media**
- **Organizing your File-Based Media**
- **Embedding Metadata in your Clips**

**Workflow: Digital Cinema & Scripted TV Productions**

Digital cameras can record footage at high-quality resolutions of 2K and up. This makes for bright and realistic images that are ideal for digital cinema productions. During the post-production process, this quality may only be required during the final finishing stages, so it’s best to use a lower resolution for the offline editing and economize on time and disk space. Depending on your delivery requirements, you can finish by switching to a higher target resolution, or conforming the project on another editing system where you can view the material at higher-than-HD resolution.

The illustration below shows a typical workflow for feature film editing using both Avid and 3rd-party applications.
For detailed procedures, see:
- “Checklist: File-Based Editing Workflow” on page 25, or
- “Editing on Interplay” on page 22

Dailies Creation

There are many companies that provide tools and technologies to streamline the preparation of dailies. The dailies process involves the fixing of timing errors, duration problems, audio/video synchronization, framing, color grading or spatial alignment. Also, when a film is shot in 3D, there are additional fixes required to adjust color and spatial alignments between the left/right eye images.

The dailies systems also inject the necessary metadata to facilitate other downstream editing processes. Not all these functions need to be completed in the dailies as they can be undertaken in the video editing application. Your workflow, timescale, storage capacity and other criteria will determine the best flexibility in the pipeline.
Once the footage to be delivered to editorial has been identified, it is typically passed on in the form of transcoded MXF or QuickTime files. The processed media is then sent to the creative editorial suite along with the associated sequence AAFs, ALEs, and LUTs from the color grading process.

If you have adequate disk storage, you can edit in Media Composer at full resolution to maintain the best possible quality. It is also possible to acquire lower resolution HD proxy footage for the selected takes, and at a later time pass a pull list back to dailies to obtain the full resolution equivalents.

**Acquisition of High-Resolution Media**

With a file-based workflow, the footage is already in digital file format so the editing system can link to media directly on a camera or storage device. Avid systems support media originating from a variety of cameras and formats which have different codecs, color encodings, frame rates and raster sizes. All metadata is taken into account during acquisition and preserved along with the project and media information.

Since file sizes tend to be large, the real-time playback of media on the timeline may be compromised. As such, it may be advantageous to transcode the footage to a lower-res format for the rough cut, and then link back to the original media before applying the final effects and outputting the sequence. Some cameras can even record in MXF formats that can be handled in Media Composer without the need to transcode.

The majority of high-resolution (2K+) file-based media comes from devices that have their own set of Look Up Tables (LUT) for advanced color management. These LUTs may come from the digital camera on which the footage was recorded, or from color grading done during the dailies processing. These LUTs need to be incorporated with the incoming media so that Media Composer can seamlessly apply the necessary color transformations at the appropriate stages during the editorial process.

**Acquisition to Shared Storage**

With an Avid shared storage solution, you can quickly increase collaboration in a post facility. There are Avid storage solutions for facilities with standalone editing systems, as well as larger networked systems requiring high-resolution storage and bandwidth.

In post productions with high shoot ratios, such as reality TV, an hour of programming can involve perhaps 100 hours of raw media to process. This requires all media to be copied from the camera storage or shuttle drive to a more robust shared storage such as a third-party JBOD or a low-bandwidth Avid ISIS 2000. Editors can link to this media and either edit directly with it or transcode it to a lower proxy resolution on a high-bandwidth ISIS 5000/7000 storage to get better performance during playback of sequences.
Linking to File-Based Media

When working with media coming directly from digital cameras or other media-creation applications, many editors use AMA to link to and edit their footage. Editing stations connected to a digital camera or card reader can link to almost any file-based media to create clips. Linking to your media, instead of importing it, can potentially save you storage space.

Dynamic Media Folders can be set up to run automated media acquisition actions on the specific drives/folders where the original media is located. These profiles can be configured to automatically move and/or transcode the media to a nearline or shared storage. All media is processed and managed in the background while you do your editing. When ready, you can update the bins to refresh the metadata for each clip and point to the new path(s) on the nearline or ISIS storage.

Audio Editing & Mixing

Basic audio tracks with surround sound and audio effects can be created in Media Composer and later sweetened in Pro Tools. This includes placing markers on the timeline to indicate where sound effects need to be added.

The key to maintaining a high level of interoperability between Media Composer and Pro Tools is to use an AAF file. This is currently the best format for transferring and reassembling the sequence or session composition from one application to another.

Export the audio tracks to an AAF and perform separate exports of the media files (e.g. QuickTime or MXF) from Media Composer. If the destination Pro Tools system has an Avid video peripheral or a Video Satellite system, you can also export Avid video tracks as part of the AAF.

When the AAF is opened in Pro Tools, it populates a new session with all the audio media and/or video metadata needed to recreate any initial edits done in Media Composer. Pro Tools can also edit with accompanying video by either importing and viewing a QuickTime file, capturing with an attached video peripheral, or viewing playback from a connected Media Composer Video Satellite system.

During the audio editing session, you can enhance the rough audio track (also known as the "guide track") produced by the video editor. The markers help spot where sound effects need to be added. You can also view any volume automation, clip gain or pan automation information imported for individual tracks and easily add and manipulate break points using the Pro Tools editing functions.

Create other necessary audio tracks for dialog, ADR, foley, music, and sound effects in either mono or stereo. When the final audio sweetening session is complete, you should mix it down, and export both the AAF and audio media back to Media Composer.
Finishing & Special Effects

Any segments that require special visual effects processing can be sent to a separate internal or external facility along with the selected source media.

Avid DS and other 3rd-party finishing systems support editing of frame sizes higher than HD and can be used for finishing and output in a format for digital cinema. Metadata from the editing functions performed in Media Composer, as well as the path to the media location for AMA-linked clips, are passed via the AAF/AFE.

The finishing editor will conform the sequence (AAF/AFE/EDL) from Media Composer and relink to the source files at the original resolution to perform compositing, special effects and color grading with a deeper set of tools.

Output and Distribution

When the production is complete, the final master can be packaged and output to various delivery formats for cinema, TV, or web. Depending on your client's delivery specifications, you will need to either export final sequence with the combined video and audio, or deliver the audio and video components separately.

Media Composer is currently limited to HDTV broadcast and distribution requirements, however all the source metadata is carried over in the AAF/AFE export so that the sequences can be conformed in a finishing application for higher than HD delivery formats.

Output SD/HD

If you are delivering a final master for broadcast or DVD format, you can output file-based footage in formats as high as HD RGB 4:4:4.

Output for Web

There are a variety of digital file formats (such as QuickTime, MP4, and MXF) for web or mobile delivery.

Send to Air

Avid video servers handle both small and large facility requirements for playback and playout operations. The AirSpeed allows you to play out multiple channels at the same time.

Before you can send your sequence to the AirSpeed from an Avid editing system, you must add the AirSpeed server to your Send To Playback list in the Avid editing application.
When the sequence is complete, the editor dynamically relinks to the high-res media and sends the final sequence to the AirSpeed playout server for broadcast or playback (this option is only available with Media Composer and NewsCutter).

Multi-Distribution System

Avid’s Interplay Pulse simplifies, speeds, and unifies distribution of content to diverse channels and devices. Interplay Pulse links production processes with distribution to web, mobile and social media outlets by orchestrating workflow and automating file preparation and transcoding. It provides a single interface within iNEWS and/or Interplay Production to create and deliver content to any selected destination platform.

Workflow: Unscripted TV Production

A high amount of TV productions today fall into the realm of unscripted programs such as reality shows, talk shows, or lifestyle shows. These programs are typically filmed with a number of cameras and microphones that are positioned around the set to allow for recordings from different perspectives. As such, the productions can have very high shoot ratios (30/1 to 100/1) with every hour of programming involving up to 100 hours of raw media to process.

With the increased availability of digital cameras on the market today, both post and broadcast facilities need to import or link to high-resolution source material from 2K or higher camera formats, but continue to edit and output web and TV formats up to HD Rec. 709.

These productions typically do not need use third-party dailies or final color tools. Avid editing systems are used for the ingest, edit, conform and final color grading. Also, since large amounts of footage are generated, the media is always edited in proxy/offline for economies in time and disk space during editorial. For the final finishing stages, the sequences are then transcoded to a higher resolution and color-corrected for the final delivery.

The illustration below shows a typical workflow for unscripted TV shows using Avid Media Composer for the entire production process.
For detailed procedures, see:
- “Checklist: File-Based Editing Workflow” on page 25, or
- “Editing on Interplay” on page 22

**Acquisition of High-Resolution Media**

With a file-based workflow, the footage is already in digital file format so the editing system can link to media directly on a camera or storage device. Avid systems support media originating from a variety of cameras and formats which have different codecs, color encodings, frame rates and raster sizes. All metadata is taken into account during acquisition and preserved along with the project and media information.

Since file sizes tend to be large, the real-time playback of media on the timeline may be compromised. As such, it may be advantageous to transcode the footage to a lower-res format for the rough cut, and then link back to the original media before applying the final effects and outputting the sequence. Some cameras can even record in MXF formats that can be handled in Media Composer without the need to transcode.
The majority of high-resolution (2K+) file-based media comes from devices that have their own set of Look Up Tables (LUT) for advanced color management. These LUTs may come from the digital camera on which the footage was recorded, or from color grading done during the dailies processing. These LUTs need to be incorporated with the incoming media so that Media Composer can seamlessly apply the necessary color transformations at the appropriate stages during the editorial process.

**Acquisition via Video Server**

(Optional) For broadcast and fast-turnaround media production environments, an AirSpeed video server is used to capture SD/HD feeds directly to shared Avid storage, freeing the Avid editing system for editing. This media can be recorded either from incoming broadcast channels or connected cameras and decks.

The Avid AirSpeed video server can be configured in one of three ways:

- In a Standalone Video Server environment, the AirSpeed 5000 uses only its own internal storage for storing clips. Clips can be transferred directly between the Avid Editor (Media Composer or NewsCutter) and the AirSpeed 5000.
- In a Team environment, AirSpeed 5000 uses shared storage (no Interplay). Clips are transferred directly between the AirSpeed 5000 and the shared storage.
- In an Interplay Production environment, the AirSpeed 5000 operates as a member of an integrated Interplay workgroup and ISIS Shared storage environment. Clips are transferred directly between the AirSpeed 5000 and the shared storage.

In an Interplay environment, you can use Interplay Capture and one or more AirSpeed servers, coupled with the Avid Interplay Low-Res Encoder to simultaneously ingest high-res and low-res versions of the same media. The assets—master clips, sequences, and bins, along with the necessary AAF metadata—are automatically checked into the Interplay database. Clips point to both versions of the media. This way editors can place clips on the timeline, work efficiently using the low-res media, and simply switch to the high-res media for the final editing and playout—see “Editing on Interplay” on page 22 for an illustration of this workflow.

While media is being ingested, you can use the Interplay Stream Publish service to automatically create streamable media that can easily be viewed over a local area network (LAN) or wide area network (WAN). The Interplay Transcode Service can transcoding the high-res media to additional lower resolutions (proxies) on an as-needed basis.

**Acquisition to Shared Storage**

With an Avid shared storage solution, you can quickly increase collaboration in a post facility. There are Avid storage solutions for facilities with standalone editing systems, as well as larger networked systems requiring high-resolution storage and bandwidth.
Workflow: Unscripted TV Production

In post productions with high shoot ratios, such as reality TV, an hour of programming can involve perhaps 100 hours of raw media to process. This requires all media to be copied from the camera storage or shuttle drive to a more robust shared storage such as a third-party JBOD or a low-bandwidth Avid ISIS 2000. Editors can link to this media and either edit directly with it or transcode it to a lower proxy resolution on a high-bandwidth ISIS 5000/7000 storage to get better performance during playback of sequences.

**Linking to File-Based Media**

When working with media coming directly from digital cameras or other media-creation applications, many editors use AMA to link to and edit their footage. Editing stations connected to a digital camera or card reader can link to almost any file-based media to create clips. Linking to your media, instead of importing it, can potentially save you storage space.

Dynamic Media Folders can be set up to run automated media acquisition actions on the specific drives/folders where the original media is located. These profiles can be configured to automatically move and/or transcode the media to a nearline or shared storage. All media is processed and managed in the background while you do your editing. When ready, you can update the bins to refresh the metadata for each clip and point to the new path(s) on the nearline or ISIS storage.

**Audio Editing & Mixing**

Basic audio tracks with surround sound and audio effects can be created in Media Composer and later sweetened in Pro Tools. This includes placing markers on the timeline to indicate where sound effects need to be added.

The key to maintaining a high level of interoperability between Media Composer and Pro Tools is to use an AAF file. This is currently the best format for transferring and reassembling the sequence or session composition from one application to another.

Export the audio tracks to an AAF and perform separate exports of the media files (e.g. QuickTime or MXF) from Media Composer. If the destination Pro Tools system has an Avid video peripheral or a Video Satellite system, you can also export Avid video tracks as part of the AAF.

When the AAF is opened in Pro Tools, it populates a new session with all the audio media and/or video metadata needed to recreate any initial edits done in Media Composer. Pro Tools can also edit with accompanying video by either importing and viewing a QuickTime file, capturing with an attached video peripheral, or viewing playback from a connected Media Composer Video Satellite system.
During the audio editing session, you can enhance the rough audio track (also known as the "guide track") produced by the video editor. The markers help spot where sound effects need to be added. You can also view any volume automation, clip gain or pan automation information imported for individual tracks and easily add and manipulate break points using the Pro Tools editing functions.

Create other necessary audio tracks for dialog, ADR, foley, music, and sound effects in either mono or stereo. When the final audio sweetening session is complete, you should mix it down, and export both the AAF and audio media back to Media Composer.

**Finishing & Special Effects**

Any segments that require special visual effects processing can be sent to a separate internal or external facility along with the selected source media.

Avid DS and other 3rd-party finishing systems support editing of frame sizes higher than HD and can be used for finishing and output in a format for digital cinema. Metadata from the editing functions performed in Media Composer, as well as the path to the media location for AMA-linked clips, are passed via the AAF/AFE.

The finishing editor will conform the sequence (AAF/AFE/EDL) from Media Composer and relink to the source files at the original resolution to perform compositing, special effects and color grading with a deeper set of tools.

**Output and Distribution**

When the production is complete, the final master can be packaged and output to various delivery formats for cinema, TV, or web. Depending on your client's delivery specifications, you will need to either export final sequence with the combined video and audio, or deliver the audio and video components separately.

Media Composer is currently limited to HDTV broadcast and distribution requirements, however all the source metadata is carried over in the AAF/AFE export so that the sequences can be conformed in a finishing application for higher than HD delivery formats.

**Output SD/HD**

If you are delivering a final master for broadcast or DVD format, you can output file-based footage in formats as high as HD RGB 4:4:4.

**Output for Web**

There are a variety of digital file formats (such as QuickTime, MP4, and MXF) for web or mobile delivery.
Send to Air

Avid video servers handle both small and large facility requirements for playback and playout operations. The AirSpeed allows you to play out multiple channels at the same time.

Before you can send your sequence to the AirSpeed from an Avid editing system, you must add the AirSpeed server to your Send To Playback list in the Avid editing application.

When the sequence is complete, the editor dynamically relinks to the high-res media and sends the final sequence to the AirSpeed playout server for broadcast or playback (this option is only available with Media Composer and NewsCutter).

Multi-Distribution System

Avid’s Interplay Pulse simplifies, speeds, and unifies distribution of content to diverse channels and devices. Interplay Pulse links production processes with distribution to web, mobile and social media outlets by orchestrating workflow and automating file preparation and transcoding. It provides a single interface within iNEWS and/or Interplay Production to create and deliver content to any selected destination platform.

Editing on Interplay

The exchange process between Avid audio and video editing systems can be facilitated with Avid interconnectivity solutions. Media Composer, NewsCutter, and Pro Tools systems support integration with Avid’s Interplay asset management system and shared storage.

Both post and broadcast facilities can configure a multi-resolution workflow, that allow producers, assistants and editors to log, mark and edit large amounts of material quickly and accurately. With Interplay Access, anyone can search or browse folders that organize assets from across all workspaces. Interplay tracks the locations of assets, including all resolutions of a master clip, and allows you to easily pull them into your project.

The latest version of Interplay supports check-in and dynamic relink of AMA (Avid Media Access) material. All AMA-linked clips will be managed in the same robust manner as MXF Avid-compliant OPAtom files. Productions with high shoot ratios can use a tiered-storage system where all incoming footage is placed on a low-bandwidth ISIS 2000 storage, linked by AMA and checked-in to Interplay. From here, select media can be transcoded to the high-bandwidth ISIS 5000/7000 storage at the desired quality for editing.

The following illustration shows how a facility can use the Avid Interplay infrastructure to manage and efficiently edit large amounts of footage. This post production environment consists of Avid video, audio and finishing editing stations, Avid ISIS shared storage, and an Avid Interplay Production driving the media management between the Avid editing systems.
Here is a suggested order in which you can prepare, edit and conform your file-based media in an Interplay environment:

1. Move the media from the camera or shuttle drives to a more robust, high-capacity drive and organize the files into a proper folder structure that works best for your facility's workflows—see “Organizing your File-Based Media” on page 34 for rules on structuring your folders.

2. After the files are organized, connect the storage to your Avid editing system(s) and AMA-link to the appropriate folders to create the necessary bins containing the linked master clips.

3. Check-in the bins to Interplay so that other workstations have access to the media for editing.

4. Transcode all your footage to a low-res proxy format (e.g. SD or DNxHD 36) resolution optimized for the offline workflow and place it on a local or shared storage.
5. Any editing stations connected to the Interplay backbone can dynamically link between the proxy or the original media when editing sequences.

6. If you were working with proxy media, you can dynamically relink back to the high-resolution AMA material when you want to consolidate a high-res version of your final sequence to your production ISIS storage. This allows you to finish the sequence using the original AMA resolution. In this case, only the portions of the AMA material that are used for the final sequence need to be stored on the production ISIS.

   In a broadcast facility, you can transcode the final sequence to the format that you need for a send-to-playback operation. In a post facility for delivery in an HD format, the sequence can be transcoded to a HD resolution suitable for finishing and final output.

7. When a sequence is ready for the effects and finishing process, the Media Composer editor exports an AAF/AFE and checks it in to the Interplay database. The online editor checks-out the AAF/AFE, and conforms and relinks to the high-resolution media. After adding the necessary visual effects and finishing touches, the sequence is rendered to the required delivery format and all the necessary project files and new media are checked back in to Interplay before the final output.

   For the audio mixing and sound effects process, the Avid Media Composer editor can export the final sequence as an AAF and check it in to the Interplay database. The sound editor using Avid Pro Tools can import the sequence and relink to the audio files to finalize the sound editing. The completed mix can then be checked back into Interplay and imported back into the video editing application for the final synchronization.

   For more information on audio-video editing workflows, see the *Audio-Video Editing Workflow Guide* and the *Pro Tools Avid Interplay Guide*. 


Checklist: File-Based Editing Workflow

This section outlines the basic workflow for linking and editing file-based footage on a Media Composer system.

*If you are editing stereoscopic media, you should also refer to the Avid Stereoscopic 3D Editing Workflow Guide for specific guidelines pertaining to acquiring and editing 3D media.*

Follow these steps in the order that they are listed, and return to this checklist each time you complete a step.

<table>
<thead>
<tr>
<th>Step</th>
<th>Refer to this section</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Before you begin:</strong></td>
<td></td>
</tr>
<tr>
<td>☐ There are a number of ways to edit your production with Avid tools. Read about the workflow that best applies to your project.</td>
<td>“Workflow: Digital Cinema &amp; Scripted TV Productions” on page 12 or “Workflow: Unscripted TV Production” on page 17.</td>
</tr>
<tr>
<td>☐ Learn how you can link to and edit high-resolution (2K+) files in the most efficient way.</td>
<td>“Considerations when Editing with File-Based Media” on page 30.</td>
</tr>
<tr>
<td>☐ Learn about high-resolution files and how they are handled in Media Composer.</td>
<td>“What's the Difference between Resolution and Size?” on page 45.</td>
</tr>
<tr>
<td>☐ Avid’s new dynamic media folders and background transcode/consolidate processes bring much more efficiency to the media acquisition stage. Learn how you can set up media service profiles to automate these functions.</td>
<td>“What is Color Management?” on page 48. “The Avid Media Access (AMA) Workflow” on page 79.</td>
</tr>
<tr>
<td>☐ Start Media Composer and create a project.</td>
<td></td>
</tr>
<tr>
<td>☐ Set your project frame size.</td>
<td>“Creating a New Project” in the help.</td>
</tr>
<tr>
<td>☐ Set your project color space.</td>
<td>“Setting the Project Format to Accomodate Variable Resolutions” in the help.</td>
</tr>
</tbody>
</table>
### Checklist: File-Based Editing Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>Refer to this section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Some media formats are supported natively in Media Composer and can be linked or ingested directly. Other formats that are not natively supported will need supporting AMA plug-ins developed by the camera manufacturers.</td>
<td>“Viewing Installed AMA Plug-ins” on page 83.</td>
</tr>
<tr>
<td>Install the necessary AMA plug-ins on your workstation.</td>
<td>Go to avid.com/ama to install the latest plug-ins.</td>
</tr>
<tr>
<td>Install QuickTime.</td>
<td>Go to the Apple web site to download Quicktime.</td>
</tr>
<tr>
<td>Enable Avid Media Access (AMA) settings.</td>
<td>“Selecting the AMA Settings” on page 83.</td>
</tr>
<tr>
<td>If you intend to use the DMF and Background Transcode services, make sure that you enable them.</td>
<td>“Starting and Stopping Avid Background Services” in the Media Composer Readme.</td>
</tr>
</tbody>
</table>

**Organizing your Media:**

<table>
<thead>
<tr>
<th>Step</th>
<th>Refer to this section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before linking or editing your media, organize it into folders on the appropriate storage to allow for better management of your media later in your workflow.</td>
<td>“Organizing your File-Based Media” on page 34.</td>
</tr>
<tr>
<td>Set the storage location for any transcoded or consolidated media.</td>
<td>“Media Creation Settings” in the Help.</td>
</tr>
<tr>
<td>For media coming directly from the camera:</td>
<td></td>
</tr>
<tr>
<td>Connect any camera or portable media drive to your system. The device will be recognized as a volume on your system from which you can read the media files.</td>
<td>“Manually Copying File-Based Media to a FireWire or Network Drive” on page 85.</td>
</tr>
<tr>
<td>Copy the media from the camera or portable drive to a designated folder on a storage device. This can also be done with DMFs and automated profiles.</td>
<td>“Creating Dynamic Media Folders” on page 86.</td>
</tr>
</tbody>
</table>

*Avid recommends that you first create a profile to do the copy. If you intend to do other functions, such as transcode, this can be done with a separate profile later in the process.*
### Checklist: File-Based Editing Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>Refer to this section</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you will be using media that has been pre-processed on a Dailies system:</td>
<td></td>
</tr>
<tr>
<td>MXF media: Place it in the Avid MediaFiles folder on your Avid editing system or a shared storage (Avid MediaFiles:MXF).</td>
<td>“Linking Media with AMA” on page 93.</td>
</tr>
<tr>
<td>Quicktime media: Place it in a designated folder of your choice.</td>
<td>“Creating Dynamic Media Folders” on page 86.</td>
</tr>
<tr>
<td>Place the AAF/ALE and any LUTs created by the dailies application in the same folder as their associated media files.</td>
<td>“Linking to MXF Media” on page 68.</td>
</tr>
</tbody>
</table>

#### Linking and Preparing Clips:

- Use AMA to link to the original camera footage. “Linking Media with AMA” on page 93.
- This can also be done with DMFs and automated profiles. “Creating Dynamic Media Folders” on page 86.
- To acquire MXF or Quicktime media created by a dailies application, use an AAF to link to the media. “Linking to MXF Media” on page 68.
- If you have any additional information for your clips, such as additional changes to the media done by 3rd-party applications, you can import this metadata using log files (ALE). “Merging Additional Metadata for Clips” on page 69.
- Add metadata to your master clips that will be required for downstream processes. “Embedding Metadata in your Clips” on page 35 and “Preparing your File-based Clips for Downstream Processes” on page 36.
- To prepare the media for editorial, you may want to apply certain changes, such as color adjustments, directly on the source media. “Changing Source Properties on a Master Clip” on page 49.
  - These changes should be applied to the AMA-linked clips rather than the transcoded clips. This way, these source changes will be available if you need to conform and link back to the AMA clips.
- Set the appropriate color space for your acquired media. “Setting the Color Properties of Acquired Media” on page 59.
For certain media types, you can also use the respective AMA plug-in to adjust the color settings. If the plug-in is installed on your system, there will be an additional tab called AMA Source Settings in the Source Settings dialog box.

- Import external LUTs into Media Composer so that you can use them to adjust the color properties of the acquired media.

- Apply (or ignore) custom color metadata attached to your media.

- If you want to remove unnecessary areas from certain clips, you can use FrameFlex to set new frame dimensions.

- If necessary, reformat some or all of your clips to fit the project frame size.

**Consolidating or Transcoding your Media:**

- Linking to high resolution files via AMA can be both processor and storage intensive. If you require better performance, you may want to consolidate or transcode your media and work with lower-resolution (proxy) versions of the media.

- If you are working with high amounts of media files that need to be transcoded, you can automate the consolidate/transcode process to run in the background by setting up an automated profile.

- If you have already created sequences that link to high-resolution media, you can transcode the sequence to a different resolution.

**Editing your sequence:**

- Perform the offline editorial using the proxy clips.

- If you need to perform any reframing or panning on your clips, it must be applied on the proxy clips in the bin.
The sequence must then be refreshed to update these changes onto any clips that are already on the timeline.

Finishing your sequence:

- If you have been using proxy clips for editing, you can relink to the source AMA clips so that you can finish and output at a better quality.
- If necessary, transcode your sequence to an HD resolution required for the final delivery. The transcoded sequence will automatically be linked to the new transcoded media.
- Color correct and apply effects to your clips.
- Add the necessary titles to your sequence.

Finishing and Applying Video/Audio Effects in Other Applications:

- To finish and master the entire sequence or just certain segments in another application, it will be necessary to export an AAF/AFE. You will also need to send the corresponding source media at the best quality.
- If the finishing system needs to relink to the original camera essence, then you need to relink to the AMA-linked clips before exporting the AAF/AFE. If you are working with high-res files, do not use the option to extend handles beyond the master clip edges.
- If the finishing system will use the same HD media, you should first make a copy of the sequence, move it to its own bin, decompose it (with handles as desired), select ALL master clips, and export as ALE with appropriate columns visible in the bin.

Refer to this section:

- “Refreshing Sequences to Use Current Clip Attributes” in the Help.
- “Relinking to Source Media for Conform and Finishing” on page 67.
- “Exporting Sequences to External Applications” on page 76.
- “Relinking to Source Media for Conform and Finishing” on page 67.
Considerations when Editing with File-Based Media

<table>
<thead>
<tr>
<th>Step</th>
<th>Refer to this section</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ You can create some basic audio tracks with surround sound and audio effects in Media Composer and send these tracks to Pro Tools for sweetening.</td>
<td>“Exporting Sequences to External Applications” on page 76.</td>
</tr>
<tr>
<td>☐ When the final audio sweetening session is complete, it is mixed down, and both the AAF and audio media are exported back for use in Media Composer.</td>
<td></td>
</tr>
</tbody>
</table>

**Outputting your sequence:**

| ☐ Render the effects in your final sequence to avoid any dropping of frames during the output process. | |
| ☐ Output the final sequence to the appropriate medium for delivery. | |
| ☑ If you want to create a master with a different aspect ratio than the project setting, you can specify mask margins on the output frame in order to change the dimensions of the output image. | “Viewing Sequences with Mask Regions” on page 70. |
| ☑ If you have a HD sequence and need to output to SD, then you need to first downconvert the project. | |
| ☑ Output your project to a tape deck or disc recorder, or | |
| ☑ Export your project to a media file such as a QuickTime movie. | “Exporting Sequences to File” on page 74. |

### Considerations when Editing with File-Based Media

Your Avid editing system can work directly with footage that is already in digital file format, such as files from digital video cameras or film scanning processes. Avid Media Access (AMA) is a plug-in architecture that allows you to link to clips and preview footage directly from a storage device without necessarily importing the media into your storage.
To link to a particular file-based format, you need the appropriate AMA plug-in installed on your editing system. There are a number of AMA plug-ins that can be downloaded from the Avid.com/AMA web page or participating third-party web sites. Install the plug-ins designed for the types of media that you will be editing.

You may begin editing with the linked source material immediately. If the media management needs of the project are not great, the project does not require several streams of video to play concurrently (as with multicam sources), and the CPU and storage is up to the task, then the offline process can continue using linked media.

System performance when editing with linked media also depends on whether the Avid editing system supports the media format natively or non-natively. NATIVE codec support means you can work with the camera media without the need to transcode first. NON-NATIVE codec support means that the media must first be imported or transcoded before the Avid system can manage it.

Media formats that have native codecs can be consolidated. Consolidating simply rewraps your files as Avid MXF OPAtom media, and places them into the Avid MediaFiles folder for indexing. Consolidating preserves the camera's original codec e.g. XDCAM stays XDCAM; DVCPRO HD remains DVCPRO-HD. The respective storage rates of the data, however, are not reduced when media is consolidated given the same original span of the media.

Media that is non-native can also be linked and edited with AMA, however, with some file formats, there may be performance delays when playing the clips. Should you need better playback performance, you can transcode the original files to low-resolution proxies. Transcoding takes the original essence and converts it to either Avid HD or SD media in a different codec with a data rate of choice. If you are transcoding to SD, then you can expect much less storage requirements for the offline. If you transcode to HD, depending on the resolution you go with, you may get little or no storage reduction benefit, but will appreciate the improved performance with Avid’s native DNxHD codec.

If you are using shuttle drives that go back and forth between the field/film set and the post-production facility, the media should first be copied to a more robust storage. When you have large amounts of footage to preview, you may have several of these storage devices connected to an Avid system. Moving your original camera essence to a nearline ISIS storage or 3rd-party JBOD (stack of drives) allows you to keep a safe location for all your incoming footage. It also gives you the opportunity to organize your files into a folder structure that facilitates the searching, editing, and management of the media. Although this means that a lot of capacity is required to hold media that might be discarded later in the editorial, it will certainly save you time during the editing process.

This footage can then be transcoded to a lower resolution for editing. The transcoded media is best placed on a central storage for all Avid systems to access. Transcoding all the camera files to low-res proxies on a high-bandwidth primary storage saves space and allows you to work with
better playback performance for the editorial. For the finishing, you may then transcode just the
required media to a higher, output-quality resolution on the primary storage. Finally, if your
project needs to be delivered in a higher-than-HD format, you can consolidate and move the
original camera essence to a primary storage where it can be accessed by the finishing
applications.

In an Avid Interplay environment, the relink process is dynamically managed. The system tracks
the different media qualities and spans, then automatically links to the resolution that you request
for HD and SD finishing workflows. On editing systems that are not managed by Interplay, you
will need to self-organize your original and transcoded clips. As an example, you can organize
your clips into separate “source” and “proxy” bins to allow you to differentiate between the
different media qualities. This will allow you to open and use the appropriate bin depending on
the resolution that you require for either the editorial or finishing stage.
Here is a suggested order in which you can prepare, edit and conform your file-based media:

1. Move the media from the camera drives to a more robust, high-capacity drive and organize the files into a proper folder structure that works best for your facility's workflows—see “Organizing your File-Based Media” on page 34 for rules on structuring your folders.

2. After the files are organized, connect the storage to your Avid editing system(s) and AMA-link to the appropriate folders to create the necessary bins containing the linked master clips.

3. At this time you should create any necessary columns in your bins and add information that will properly identify your clips for the downstream conform process.

4. Any preparation of media for the editorial process should take place on the AMA-linked master clips so that they will available for the conform stage as well. These adjustments typically include general color and spatial adjustments that need to be applied to all files from the same camera. When transcoding your media, you will have the option to apply these adjustments to the new media.

5. Transcode all your footage to a low-res format (e.g. SD or DNxHD 36) resolution optimized for the offline workflow and place it on a local or shared storage.

6. Build a rough-cut of your sequence by previewing and cutting with the proxy clips. Once you start editing with the proxies, any further color or spatial adjustments need to be applied to the source proxy clips in the bin. You then need to refresh the sequence(s) in order to propagate the adjustments.

7. If your Avid editing application has difficulty with real-time preview of effects, you can either render your effects to create new media, or try changing the timeline setting from green/green to green/yellow or yellow/yellow—see “Options for Controlling Real-Time Effects Playback” in the help.

8. Relink your sequence to the bins holding the AMA clips and continue the finishing process on Media Composer, or export the sequences as AAF/AFEs for finishing and effects on other editing systems.

9. Transcode the sequence to a higher-resolution for the finishing and output.

For detailed procedures on each of the steps above, see “Checklist: File-Based Editing Workflow” on page 25.
Organizing your File-Based Media

Avid recommends moving all your camera footage to a robust storage, and organizing the source files in a manner that will ease the search for specific footage. You can structure and name the parent folders as you see fit (e.g. REDCAM1, REDCAM2, Day 1, Day 2) but it is important that the actual card structures from the camera remain as they were shot. Typically, these folders contain metadata files that need to remain with the camera media.

When organizing your files, keep the following in mind:

- Folder names should be limited to 14 characters.
- Folder names should be only letters, numbers, and underscores – no spaces or symbols. You will not be able to AMA link to a volume or file if the file path name has an illegal character. AMA clips display offline if the file path name you are linking to contains illegal characters, including < > : / ? *, for Windows and : for Macintosh.
- During the AMA-linking process, you can select a subfolder containing the media files. AMA can find and link to these files as long as they are not more than 2 folder levels down from the selected folder.
- Windows UNC (Universal Naming Convention) paths are supported with AMA media. You can move your AMA bins from a Windows system to a Macintosh system and from a Macintosh system to a Windows system. The media files need to reside in the same shared location when you move the bins to and from different operating systems.

After all media has been moved to the storage, create an archive of the organized drive for backup.
During the editorial process:

- Do not rename or reorganize the folders with the original media once the editorial has begun.
- Do not delete the clips or bins created by the AMA process. You can close them and reopen them later when you need to relink to the original media either on Media Composer or another editing system.

**Embedding Metadata in your Clips**

In most post-production workflows, you can pre-process your media in a third-party dailies application, edit a program in an Avid editing system, and then transfer your program to another Avid or third-party system for final finishing. Similarly, within Media Composer, you can start by linking to source media, edit with low-res media (proxies), and then relink back to the source media for output.

Unlike tape-based workflows—where tapes are physically labeled and correlate to those labels when captured—it is easy to lose track of file-based media. The only physical source is a file on a drive. If a file is moved from the location where it was at the time the initial ingest was done, finding the media can become a very manual process. If you intend to move your projects to or from other systems for pre-processing, effects, or finishing, something important to note is the origins of the source files.

Avid recognizes and tracks the filename and this should not be changed. Other systems might interpret Source or Reel ID as filename options, which can have an impact on the relinking to the source files or final conform. Also, some of the dailies solutions that license the Avid Media Toolkit (AMT) can create native MXF-wrapped DNxHD media directly from the system. Third-party applications will each manage the source essence metadata differently.

Additional bin columns with information such as Camroll, Camera, Labroll, etc. should also be added to the master clips prior to performing any transcodes. Although these column names are rooted in film-centric workflows, they can be used in a more modern, file-based context. Camroll could be the "card" number or asset number assigned by the production; Camera could be the manufacturer and model of the Camera, and Labroll could be the RAID drive itself (Labroll being appropriate since it's the amalgamation of several camera rolls). This may become useful downstream, as these columns can be used as source in an EDL.

The strength of Media Composer’s metadata management allows for all formats of source tracking to be managed and output in either EDLs or AAFs as needed in the post-production pipeline. You can create as many user-defined entries as desired—they will all be tracked and made available for downstream use. For a complete listing of all data entries that can be tracked, managed and manipulated, refer to the *Avid Metadata Logging and Tracking* document in Avid Knowledge Base.
Embedding Metadata in your Clips

Any additional information that you are adding, for file tracking or as notes, needs to be applied on the original master clips (and not on the transcoded proxy clips) so that the information is carried from the offline to online editorial—see “Preparing your File-based Clips for Downstream Processes” on page 36.

Preparing your File-based Clips for Downstream Processes

Many productions may choose to use AMA to quickly view the footage in real time, make notes and comments, then transcode to an offline resolution. The advantage of this process is that all notes and comments created at this point will persist throughout the editorial.

Any information, along with additional comments and media descriptions must be applied to the source clips (and not on the transcoded proxy clips) so that the metadata is available when relinking the sequence back to the original camera essence. If the sequences will be finished with other editing systems, this metadata will also be needed for further processes.

For a complete listing of all data entries that can be tracked, refer to the Avid Metadata Logging and Tracking document on avid.com.

To add information to the master clips:

1. Change the default bin display by adding the necessary columns to the bin holding the source clips. Amongst others, the column headings that should be shown include: Name, Take, Camera, Camroll, Labroll, Tracks, FPS, Format, Video, Auxiliary TC1, Start, End, Duration, Drive, Tape ID, Source File, Source Path.

2. Create a custom bin display setting and save it.

   At the bottom of the bin, there is a button labelled “Untitled” by default. Click on it and choose Save As... to enter a name for the bin display.

3. Create other bins that you will use to store your file-based media, and apply the custom bin display setting to them so that the necessary columns will be displayed.

4. Refer to the tables below for further actions that need to be taken for certain bin columns.
## Embedding Metadata in your Clips

<table>
<thead>
<tr>
<th>If your workflow involves...</th>
<th>Take these steps...</th>
</tr>
</thead>
</table>
| Relinking between source and transcoded clips | If your editing system is not within an Interplay environment, you will need to manually relink to the clips of the desired quality.  
See “Metadata for Relinking Processes” on page 38. |
| Creating DNxHD proxy material via a dailies process | The important consideration here is how the source files are going to be created by the dailies creation systems. These systems will always put some form of source filename in the Tape column.  
See “Metadata Interchange for Applications using Avid Media Toolkit (AMT)” on page 41. |
| Exchanging clips/sequences via an EDL: | See “Metadata for EDL Interchange” on page 40. |
| Exchanging clips/sequences via an AAF: | Some third-party systems do not recognize conforming sources being tracked in the Source File column when using AAF as legacy workflow and vendors’ implementations have always been to track sources in the Tape field.  
See “Metadata for AAF Interchange” on page 39. |
| Repurposing Audio Data from BWF Files: | When AutoSyncing, Media Composer always defaults the name of the resulting .sync clip to the name of the video clip. But in a file-based world, the name of the file is a less than relevant name to the editor, such as A004C010_20100610_R1JL in the case of an ARRI-created ProRes file. If the Scene and Take were logged on set, the resulting Name of the clip, once imported, will be Scene/Take in the “Name” column. |
Embedding Metadata in your Clips

If your workflow involves... | Take these steps...
--- | ---
Before AutoSyncing, create a custom column and duplicate the contents of the “Name” column into that column by using “command-D” or “control-D” and selecting SoundRoll from the pop up dialog box. Once the clips are synced, select the custom column with the Scene/Take information and duplicate it back into the Name column. In two easy steps, all clip names from that day’s dailies are named.

The entire BWF filename ends up in the TapeID column, which is not available to EDL Manager as a source when generating EDLs. It is suggested that you highlight the entire TapeID column and create a “duplicate column” by using a “command-D” or “control-D” and selecting SoundRoll from the pop up dialog box. This will copy the entire contents from one column to another and is now available in EDL manager as a source reel.

Metadata for Relinking Processes

AMA offers the advantage of allowing you to transcode material to a lower resolution at any stage of the process. In order to easily relink between your source and transcoded clips, you need to do the following:

• Verify that the frame rate of your original clips matches the frame rate of your project. e.g. if your media is 23.98 fps, you must be working in a 23.98 fps project.

• Make sure that you make the adjustments as described in the table below.

You will be required to create custom columns and duplicate information between columns. If you don’t know how to do so, refer to Adding Customized Columns to a Bin” and “Copying Information from Another Cell in a Custom Bin Column” in the help.
Embedding Metadata in your Clips

**Name**
Initially, this is the name of the camera file. You can rename this to something more relevant (i.e. Scene 32B-2, instead of MVI_3722)

**Drive**
*Important!* The drive name will change after you transcode to SD so add it to the Tape ID or other custom column to keep a record of where the clips originally came from.

**Tape ID**
If this column does not already contain data, select the “Drive” column and duplicate into this column. (Choose Control + D (Windows) Command + D (Mac) and select Tape ID from the window that pops up.)

*Important: If TapeID already contains metadata, already as in the case of BWF import, then create a custom column to place the Drive information.*

**Take**
Copy the file name into the Take column, thus preserving the original file name (in case the clip gets renamed during editorial).

**Camera**
Enter the camera model number into this column (example: 5D, 7D, 60D, C300, Sony F3, REDONE, P2) since once the clips is transcoded and/or renamed, it will be less apparent what camera created the file.

**Camroll**
Use this field to introduce a “Tape Name,” a barcode number, an asset or library number etc.

**Auxiliary TC1**
*Important! Since Avid v5.5, all Quicktime-based sources that lack native TC have their creation date dropped into this column in the form of video TC. (Example: a 5D file created 20 seconds after 8:30pm would thus become 20:30:10:00)*

- Do not apply an Avid Tape Name. This will interfere with the relink during conform. Instead use Camroll as the proper field to introduce a “Tape Name”, a barcode number, an asset or library number, etc.

**Metadata for AAF Interchange**

AAF (Advanced Authoring Format) is an open standard originally initiated by Avid, but quickly adopted by many vendors, hence an association was created. The association is now called the Advanced Media Workflow Association (http://www.amwa.tv/) and anyone can join and participate in the definition of the open standard.

There are two types of AAF export available in Media Composer: AAF and AAF Protocol. AAF Protocol is a subset of the AAF, as its primary goal is to establish a well-defined, albeit more constrained, set of the AAF to ensure 100% compatibility between vendors. An AAF Edit Protocol may not support all the latest VFX and layer/nested elements in a composition. As such,
it sits between an EDL (most basic representation of a sequence) and AAF (most rich
representation of a sequence). The added advantage of AAF Edit Protocol export with Media
Composer is that it can be used for media that is currently being managed and edited via AMA.
The richer form of the AAF file can only be exported if the AMA-linked media has been
transcoded and managed by Avid in the Avid MediaFiles folder structure. The same goes for
EDL creation; in order to create an EDL from an active AMA-linked sequence you open the bin
directly from within EDL Manager as the integrated "get sequence" function relies on an AAF
interchange.

Some third-party systems do not recognize conforming sources being tracked in the Source File
column when using AAF as legacy workflow and vendors' implementations have always been to
track sources in the Tape field. If this scenario presents itself, generating an EDL will solve the
problem at the risk of losing some of the supported additional VFX metadata.

AAF export presents a variety of options, but when referencing the original camera assets and
not the MXF proxy, a "link to" is all that is needed. Additional management is based on track
selection as well as spans within the track, depending on conform needs at the time of
generation. For example, just the video tracks may be sent to a DI color correction system, while
an audio-only AAF is sent to an Avid Pro Tools system. There are no further options to select as
all related metadata of the sources and sequence creative decisions are in the AAF file.

Before generating the AAF, the user may want to simplify the sequence, especially in the case of
multicam sources. Instead of sending all the sources, whether they were used or not, the
sequence can be optimized to remove the group information and only reference the active camera
angle/take used in the final sequence.

**Metadata for EDL Interchange**

In Media Composer, the following columns can be used for source identification in an EDL
depending on where that source file name is being tracked:

- Tape
- Source File

The following are available as options to override Tape or Source File if needed:

- Labroll
- Camroll
- SoundRoll

As mentioned earlier, depending on how dailies got created: via a third-party system, direct tape
capture, or AMA/Import, the source identification will most likely fall into either the “Tape” or
Source File” column in the bin. Since an EDL has to have some form of reel ID, Tape and Source
File are combined as the default setting for EDLs. The result is that EDL Manager will first look
to a value in Tape and use that; if none is found, then it will look to Source File. If there is no modification of sources by the user, there will never be a value in both columns at the same time; it is either one or the other.

In some scenarios, a version of the source file may exist in either Tape/Source File and in a column such as Labroll or Camroll. This is due to the fact that some cameras such as RED and ARRI ALEXA will provide an 8-character version of the filename to either support a legacy CMX3600 EDL format or NLE system that does not track and generate full filenames in the EDL. In these scenarios, the “8 character” Reel ID can usually be found in either the Labroll or Camroll columns.

Here’s an example of an ARRI ALEXA ProRes recorded file where there are two source file names available for the same file:

- A064C001_120524_R2G4
- A064R2G4

The longer file name will be tracked in either the Tape or Source File column, while the shorter 8-character version will be in either the Labroll or Camroll column. How and where these file names get tracked is based on a variety of factors: where the vendors choose to track them, where the software solution providers decide to track them, and in the end, where the individual user wants to track them.

Any of this information, along with additional comments and media descriptions, must be applied to the source clips (and not on the transcoded proxy clips) so that the metadata is available when relinking the sequence back to the original camera essence—see “Preparing your File-based Clips for Downstream Processes” on page 36.

**Metadata Interchange for Applications using Avid Media Toolkit (AMT)**

Some of the dailies solutions that license the Avid Media Toolkit (AMT) can create native MXF wrapped DNxHD media directly from the system. Some systems may only use the freely available Avid DNxHD QuickTime codecs and create the same essence with a QuickTime wrapper rather than MXF. All of these can work, but will have some impact on different parts of the workflow and the amount of source essence metadata being managed. Also note that native MXF-wrapped DNxHD media cannot be imported directly into a bin. These files must be copied or moved to a folder within the Avid MediaFiles/MXF/ folder hierarchy.
Embedding Metadata in your Clips

A few things to keep in mind when using footage created by AMT in third-party applications:

- Media created by these solutions are not associated with an Avid project name. These files can be used in any project, but when looking at them in the Avid MediaTool, they will not be associated with a project. The only way to associate media with a project is to have that project create the media in the first place via a tape capture, import, link, render or transcode.

- Source ID of the original camera media is only tracked in the TAPE column once in Media Composer. Only AMA and direct import into Avid will use the original filename (as seen at the directory level including extension) in the Source File column. There may very well be a mismatch between this and a direct import of the same file, which needs to be considered and managed accordingly. Media Composer now has improved flexibility in relinking files being tracked in different columns and with varying different nomenclature.

- Some systems will insert both the filename and the reel ID from raw files into the ALE file that can then be merged to the dailies to have both sources being tracked. Other systems will allow exporting of MXF wrapped DNxHD without any Tape or Source File ID which will cause problems in relink or conform downstream. Ensure that a REEL ID is always assigned.

- Audio transcoded via AMT does not have the ability to be addressed on the ¼ frame boundary for accurate sub-frame syncing. This feature only works when audio media is created within a film-based project (35mm, 3 perf or 35mm, 4 perf) in Media Composer.

The new iXML AMA plug-in will not allow subframe resync when in a film project.

- Limited metadata is added to the MXF wrapper, usually containing the source ID and timecode via the START column only. All other metadata is typically exported as an ALE file (Avid Log Exchange), if offered, which can be merged into the master clips before editing starts.

Any of this information, along with additional comments and media descriptions, must be applied to the source clips (and not on the transcoded proxy clips) so that the metadata is available when relinking the sequence back to the original camera essence—see “Preparing your File-based Clips for Downstream Processes” on page 36.
## 2 Working with High-Resolution Media

The following diagram shows the different points in the pipeline where you will be able to set your image format properties for display and output. It also indicates the places where the color transformations are applied in order to maintain the proper color appearance from acquisition to output.

1. **Open/Create a Project**

   Media will originate from different sources such as file-based cameras, film frames scanned to files, SD or HD tapes, and even computer-generated motion graphics. Each of these media sources can have arbitrary sizes, resolution, frame rates, compression and color encoding (color model, gamma, bit depth, etc.).
Media Composer gives you the ability to capture, import, or link to media coming from different sources, regardless of their resolution, and mix them freely in the timeline. Of course, all this media needs be output to one frame size, hence it is important to set a common frame size in the Avid editing application.

The application also needs to use a common color space for all media in the project so that a common transformation model is applied to all incoming media.

**Step 2. Acquire and Interpret Quality of the File-based Footage**

When linking to media, you have access to all of the pixels in the source image. However, to fit the final delivery format, you need to set the project size so that media of different sizes and formats can be reformatted to specification.

File-based media can be linked or imported. Linking to media via AMA allows you to view the image in its original format. Importing the media reformats the image to the frame size of the project. If you link your clips, you will be able to view the media in its full resolution and thus have greater flexibility when mapping the media to the project settings. You can use the full image or select a region to be framed, and then choose how to format the media to the SD or HD project size.

When the master clips are created in the bin, any associated color metadata (coming either from the camera or other upstream processing) can also be detected and applied. Media Composer keeps all source metadata with the master clips. This metadata will also carry over in the AAF/AFE export so that the sequences can be conformed in a finishing application for higher than HD delivery formats.

**Step 3: Edit the Sequence**

For the editing process, the project format in Media Composer is currently restricted to HDTV broadcast and distribution requirements. Once a clip is placed on the timeline, it will reformat to fit the media conversion settings that you have chosen for your project.

For further efficiency during the editorial, there is the option to transcode to a lower resolution (proxy).

**Step 4. Apply Effects**

Any effects applied to clips on the timeline will be applied to the area of the image displayed in the viewer. These will be processed on-the-fly during playback, and any precomputes will be rendered to the disk storage. (Note: Processing is done using the settings in the Media Creation dialog).
What's the Difference between Resolution and Size?

Quite often, the terms resolution and size are used interchangeably. There is a difference between the two and it's important that we clarify the meaning of each one so that you understand how your media is formatted in the editing application.

The resolution of the media refers to the number of pixels that compose the image. Naturally, the more pixels in the image, the higher your resolution will be, and the better the quality of the image. The resolution is typically defined by the number of pixel columns (width) by the number of pixel rows (height).
What's the Difference between Resolution and Size?

HD images are usually 1920 by 1080, and high resolution images are typically 2K and above. These resolutions vary depending on the camera that shot the footage. For example, an ARRI 3K image is 2880 x 1620, whereas a RED 3K image is 3072 x 1728.

The **size** refers to the physical space that the image occupies in a particular display or print area. Size is simply used to provide a common reference for the framing of images of different resolutions.

Let's use the analogy of a digital photo that you want to have printed and framed. Your photo is shot at a high quality resolution e.g. 3264 x 2448 and you want to print it to fit in a 5” x 7” picture frame, as well as in a 15” x 20” frame. When the photo is enlarged to fit in the larger frame size, each pixel increases in size. Thus, when looking at each of the photos up close, the image in the smaller frame will be much sharper. The number of pixels, however, remains the same. They are just more tightly packed in the smaller frame size.

There will be cases when the image is required to fit into a frame size that is of different dimensions than the original image. For example, if the 5” x 7” photo had to be framed into a 6” x 9” picture frame, it could either be cropped or left as is and framed with a matte.
What's the Difference between Resolution and Size?

Similar choices can be made when editing video. The examples below show how an image can be framed in the Avid editing application. An image can be rescaled, cropped, or padded to fit the project frame size. The pixels in the image are simply shrunk or enlarged as necessary.
What is Color Management?

Since most cameras record at a high precision, it would be ideal to preserve the maximum precision and color range right through the editing process. Color management enables you to retain the colors of the original images and maintain that color appearance during editing.

During acquisition (either by baseband capture, import or link to file), Media Composer will automatically detect the color encoding of the footage and will allow you to choose the color space that best matches the footage. Media Composer will perform the necessary color transformation of the footage in order to map the colors to internal application functions.

The color space that you choose depends on your final delivery format needs. For this release of Media Composer, color mapping is limited to Rec. 709 which is suitable for HDTV broadcast. If you are delivering a master for cinema distribution, then you can leave your color space as is and let the colorist do the necessary color transformations in the finishing tool.

The original color encoding will remain with the master clip metadata for use throughout the editing pipeline, ready to translate the image's colors for other devices at any given point (e.g. for viewing on the monitors). Part of the color encoding includes "look" tables (or LUTs) that can be passed along with the media to ensure that a consistent color is applied to all related footage. The color management system will take the colors in an image and map them as accurately as possible to the color model chosen for the editing process. This color mapping is either done 'on-the-fly', or can be rendered to new media after any effects are applied.

Color mapping also takes place on each device where you view the footage. The Avid system can be connected to a variety of monitors, and each model will display colors differently. For example, say that a certain color coming from a digital camera is turquoise blue (represented by RGB numbers R75, G201, and B220), but appears closer to sea green on a monitor. The color management system needs to translate the RGB numbers to the equivalent numbers required by the monitor in order to preserve the turquoise blue appearance. This translation is performed by setting the appropriate color profile on the monitor. (Note: For this release, only Rec. 709 color profiles will be supported on the viewers and external monitors.) If you want to simulate the colors as they will be projected for final delivery, then you can must calibrate your external monitor accordingly.
Changing Source Properties on a Master Clip

To ease the editorial process, Avid provides a number of tools to preview the original essence from the camera and make adjustments to the incoming media or its metadata. Any adjustments made to the master clips are applied as source adapter effects.

Import or AMA-link to your file-based media in the usual manner. After media has been acquired and the master clips have been created in the bin, you will be able to view and adjust the media properties from a single Source Settings view.

The Source Settings dialog box detects the properties of the source media based on the metadata that was found with these files. It allows you to quickly see the properties of the input files and make changes if necessary. You can also view any framing applied on the image, as well as a histogram showing the range of colors in the image.

If there is an AMA plug-in installed on your system for this media format, then an additional AMA Source Settings tab will be available. Any settings on this tab will be applied before the Color Encoding tab.

The Source Settings dialog box allows you to:
- set the aspect ratio of the media
- set the color space of the media
- apply specific color transformations to the source media
- choose the way you want to format the source into the current project frame size
- select a smaller area of the overall image size to be displayed in the project frame
Some of these settings can be set directly in the bin columns.

Imported clips will already be resized to the project size and aspect ratio. However, it is still possible to reframe or reformat the imported clip.

A Spatial Adapter effect is applied either when the clip is reframed, or reformatted to fit within the project frame size. A Color Adapter effect is applied when a color transformation applied to the clip. When the clip is placed on the timeline, any of these changes will be indicated as adapter effects and will display as green dots on the clip. These effects can be modified with the Effect Editor and rendered to allow for smooth playback and output.
Reframing your Media

For various reasons, it is common practice to shoot at a higher resolution than the final output intentions. Framing charts, that define the dimensions of the final output, have been developed for camera viewfinders so that the camera people can keep the proper perspective in view while filming.

The framing chart used during the onset shoot is usually filmed as the first frame of the shot. Some digital cameras even include these framing parameters in the file metadata that is passed through to the Avid editing application. During post production, these framing parameters serve as guidelines for the editing process, and this intended action area can be automatically framed to the project frame size.

During the onset shoot, certain objects (such as lights, flags and other on-set equipment) may inadvertently be recorded within the main viewing area. As part of the dailies process, these objects may be trimmed out from the region of the image that is presented to editorial. If not, then the post editor is required to crop out and reframe the image as necessary.

If the framing parameters were included in the media metadata, then the Framing view will reflect the same area used during the onset shoot. If necessary, the editor can adjust these dimensions manually.

Clips are reframed by applying a spatial adapter on the clip in the bin. The Source Settings dialog has a FrameFlex tab where the dimensions of the framing box can be adjusted. The area within the framing box is what will finally be fit into the project frame when the clip is used in a sequence.

The reformatting settings for each clip are saved in the bin. When the clip is dropped on the timeline, a green dot appears on the clip to indicate that a source adapter effect has been applied. The application accesses the original image and applies the formatting during playback. Effects are applied and rendered based on these settings.

For clips that have already been used in a sequence, the sequence can be refreshed to frame to the new dimensions.

To set the framing dimensions:

1. Select one or more clips in the bin, right-click and choose Source Settings.
2. If the image viewers are not displayed in the Source Settings dialog, click the Show Viewers checkbox.
3. Select the FrameFlex tab.

The framing options display with the framing box outlining the full image.
If framing parameters were passed from a camera vendor that is an Avid partner, then the framing view used on set may be displayed in the viewer.

4. In the FrameFlex box, adjust the Framing parameters to set the new dimensions of the framing box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Same size as project’s raster dimensions</td>
<td>Sets the framing box at a 1:1 ratio with the project frame size.</td>
</tr>
<tr>
<td>Frame aspect ratio</td>
<td>Changes the size of the framing box according to the selected aspect ratio.</td>
</tr>
<tr>
<td>X</td>
<td>Reposition the framing box along either the X or Y axes.</td>
</tr>
<tr>
<td>Y</td>
<td>Resize the framing box proportionally.</td>
</tr>
<tr>
<td>Size</td>
<td>Set color of framing box outline in the viewer.</td>
</tr>
<tr>
<td>Color</td>
<td>Resets the framing to the original size.</td>
</tr>
<tr>
<td>Revert</td>
<td>Reverses any changes you made since the last time the Apply button was clicked.</td>
</tr>
<tr>
<td>Stretch</td>
<td>Stretches the image (disproportionally, if necessary) to fill the project frame.</td>
</tr>
<tr>
<td>Pillarbox/Letterbox</td>
<td>Scales the image proportionally until either the height or the width extends to the project frame. Black bands will appear on the sides (Pillarbox), or on the top and bottom (Letterbox) in order to pad the empty areas of the frame.</td>
</tr>
<tr>
<td>Centre Crop</td>
<td>Scales the image proportionally to fill the project frame. Areas that fall outside of the project frame will be cropped.</td>
</tr>
<tr>
<td>Centre, Keep Size</td>
<td>Centers the image in the viewer without modifying its original size. Areas that fall outside of the project frame will be cropped.</td>
</tr>
<tr>
<td>Revert</td>
<td>Reverses any changes you made since the last time the Apply button was clicked.</td>
</tr>
<tr>
<td>Apply</td>
<td>Applies all selections that you made so that you can see the changes in the viewers.</td>
</tr>
</tbody>
</table>
5. The bottom viewer displays the framed area as it would appear within the actual project frame. Refer to “Reformatting the Media to fit the Project Frame Size” on page 56 for more details on the choices that you have.

6. Click Apply.

   The new framing of the image will be applied when you drop the clip in the Source viewer or on the timeline. A green dot on the clip in the timeline indicates that spatial changes (in the form of a spatial adapter effect) have been applied to this clip.

7. If you had placed your clip on the timeline before doing the reframing, you can refresh your timeline with the changes—see “Refreshing Clips to Use Current Clip Attributes” in the Help. (Choose Refresh Sequence > Aspect Ratio and Reformatting Options.)

8. If you want to make further changes to the framing box from the timeline, open the spatial adapter effect for this clip—see also “Panning a Shot” on page 54.
Panning a Shot

If you want to pan and scan over a segment of video, you need to apply a FrameFlex source adapter to the clip in the bin. When the clip is placed on the timeline, a green dot will appear on it and you can open the Effect Editor to change the framing box and animate it for the necessary duration—see “Reframing your Media” on page 51.

If the clip was already part of the sequence before you applied the FrameFlex source adapter, then you will need to refresh the sequence so that inherits the newly-set attributes from the clip in the bin—see “Refreshing Clips to Use Current Clip Attributes” in the Help. (Choose Refresh Sequence > Aspect Ratio and Reformatting Options.)

If the clip still references the source media, you will see all the pixels in the image. You simply have to set the framing box over the area that is required in the focus and make sure that the box shifts to a new position in subsequent frames in order to follow the important action. These positions should be keyframed to create the effect of a "pan" shot.

To animate the framing parameters:
1. Select the clip on the timeline and click the Effect Mode button.
   The Effect Editor displays.
2. Select and expand the FrameFlex effect.
   The Record viewer becomes your workspace to adjust the framing parameters.
3. Click in the position bar below the Effect Editor at the point in the effect where you want to add the keyframe.
   The record viewer displays the frame and the framing box.
4. Adjust the size and/or position of the framing box.
   For example, drag the handles on the corners of the image to resize it, or click and drag to move the entire box. The Avid editing application automatically creates a new keyframe on this frame.
5. Move the position bar to another point where you want to add a keyframe and repeat the above step.
6. Click the play button to see the results of your animation.

If you need to disable this effect, click the Layout button. When the button is gray, the effect is bypassed.

If you need to reset any keyframe to the original framing dimensions, move the position bar to the respective keyframe, then press ALT and click the Layout button.
Reformatting the Media to fit the Project Frame Size

In the Source Settings dialog box, you have the option to reformat the entire image or just the area within the framing box to the current project format.

The reformat image option is also available in the Effect Editor if you need to apply a change to a clip on the timeline.

To reformat the image to the project frame size:

1. In either the bin or on the timeline, select the clip that you want to change, right-click and choose Source Settings.
   The Source Settings dialog box displays with the viewer showing the first frame of the clip with the current framing dimensions.
2. Select the FrameFlex tab.
3. Select the appropriate Reformat option.

   When using media of a different format from the project format, you can specify how the media will be converted in the application by using one of the modes below:

<table>
<thead>
<tr>
<th>Reformat Options</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stretch</td>
<td>Stretches the image (disproportionally, if necessary) to fill the project frame.</td>
</tr>
<tr>
<td>Pillarbox/Letterbox</td>
<td>Scales the image proportionally until either the height or the width extends to the project frame. Black bands will appear on the sides (Pillarbox), or on the top and bottom (Letterbox) in order to pad the empty areas of the frame.</td>
</tr>
<tr>
<td>Centre, Keep Size</td>
<td>Centers the image in the viewer without modifying its original size. Areas that fall outside of the project frame will be cropped.</td>
</tr>
<tr>
<td>Centre Crop</td>
<td>Scales the image proportionally to fill the project frame. Areas that fall outside of the project frame will be cropped.</td>
</tr>
</tbody>
</table>

The results of your changes will be displayed in the bottom viewer.
Areas of the image that fall outside of the project frame size, will be cropped. On the other hand, if the image is smaller than the project frame size, it will be padded with black.

Once a clip is placed on the timeline, it will reformat to the project frame size according to the media conversion settings that you have chosen. Note that any reformatting options are processed on the fly during playback and do not affect the source clip.

4. Click Apply.

The new formatting of the image will be applied when you drop the clip in the Source viewer or on the timeline.
Example of Reframing and Reformatting

The following example shows a 2K image with a framing box set around the desired area of the image. The application first crops out the unwanted area and then fits the image within the project frame size (using the letterbox/pillarbox option selected by the editor).

Defining the framing box

Reframing and reformatting applied
Setting the Color Properties of Acquired Media

The application preserves all color metadata from the acquisition process. This includes color information embedded in the raw footage, as well as in accompanying conversion tables (LUTs, CDLs) that can be associated along with the media to ensure that a consistent color is applied to all related footage. This information is saved with the clip in the bin.

For other common digital cameras, Avid provides a standard set of camera conversion tables that will map the camera color values to the color space used in Media Composer.

*Camera vendors that have partnered with Avid also supply AMA plug-ins for specific camera formats. Refer to “Using AMA Plug-Ins” on page 104 for more details on using these formats in Media Composer.*

A look-up table (LUT) is a file that contains a conversion table used to map an input color value to an output color value. LUTs are used for the following reasons:

- To ensure a standardized color output value across different devices such as computer monitors, broadcast monitors, and film projectors.
- To offer flexibility in editing and post-production when working with media from different sources or shot with different cameras.
- To convert logarithmic media files to linear format prior to editing and applying effects.
- For creative or artistic purposes to obtain a particular “look and feel” to a scene.
- To determine how the color data of the final image will be displayed.

Media Composer automatically detects color management attributes encoded in the camera format. The camera manufacturers need to structure their metadata according to the Avid requirements to allow for these values to be passed on to the editing application. Refer to the web sites of your camera manufacturers to find out if their file formats include the necessary color management attributes.

For more information on other ways that custom transformations that can be applied to your media, see “Using Color Decision Lists (CDLs)” on page 64.

**To change the color encoding of the source media:**

1. In the bin, select one or more clips that you want to change, right-click and choose Source Settings.

   *Certain file formats that have an AMA plug-in installed on your system will also reveal an AMA Source Settings tab. In the case of RED media, for example, the color space adjustments should be made on this tab.*

2. Select the Color Encoding tab.
The Source Settings dialog box displays with the viewer showing the first frame of the clip with the current color encoding.
Setting the Color Properties of Acquired Media

3. If you know what color transformation you want to apply, select it from the Color Transformation list, and click the + button.

   The transformation is added to the list and applied to the image in the viewer.

4. You can add more than one transformation if necessary, and change the order in which they are applied by selecting and dragging the transformation up or down in the list.

---

**Color Encoding Parameters**  **Descriptions**

| Source color space | For some known camera formats, the application reads the color space metadata within the source media, and displays the most appropriate color space. If you know the color space of the media you can select it here and this information will remain with the clip for other downstream processes.

   You may leave it as Unknown if you do not know the color space of the media. In this case, the application will leave the colors as they are.

   If you click the Auto button, the application will do the necessary color mapping to go from the specified color space to the project’s color space (Rec709). This color transformation will take place when the clip is used in a sequence.

   [list of color transformations] To apply an additional color transformation to the media, select an option from the drop down list and click the Add button. You can add more than one color transformation to your media.

| Delete | Select a transformation from the list of applied transformations, and click Delete to remove it.

| Auto | Clicking this button will apply the assigned (detected) Source color space to the media.

| Bypass all color transformations | Ignore all color encoding settings. This may be required if you need to send a particular segment for special effects processing without any transformations that you have applied during the editing process.

| Revert | Reverses any changes you made since the last time the Apply button was clicked.

| Apply or Apply All | Applies the settings to all clips that you selected in the bin. Color changes will be visible in the viewer. |
Transformations are applied cumulatively starting from top to bottom.

5. Click OK to close the dialog box.

When clips are viewed in the Source monitor or dropped on the timeline, any associated look files (LUTs, CDLs, etc.) are also considered when the color transformation is applied. This will be reflected when the clips are played back. You can also choose to apply these changes to any new media generated through transcode, consolidate or mixdown.

If the clip was already part of the sequence before you applied the color adapter, then you will need to refresh the sequence so that inherits the newly-set attributes from the clip in the bin—see “Refreshing Clips to Use Current Clip Attributes” in the Help. (Choose Refresh Sequence > Color Adapters.)

Applying External LUTs to your Media

Avid provides a standard set of industry color transformations that you can apply as source settings directly to the master clips. Avid also provides the ability to load custom look-up tables that have been provided by the camera operator, the director of photography, the film scanning facility, or the colorist during the dailies processing. A LUT is essentially a file that contains a conversion table used to map an input color value to an output color value.

The application supports two different types of LUT formats:

- 1D LUT: A 1-dimensional lookup table maps each input channel value to an output channel value on a per-channel basis (independently for each channel R, G, and B).
- 3D LUT: A 3-dimensional lookup table maps any given color value (R,G,B) to an output color value (R,G,B). Mistika, LUTher, Kodak KDM, and IRIDAS formats are examples of 3D LUTs that are supported.

A list of supported products or file extensions have been listed below. Other product LUTs may be supported but the first line entry of the file must appear as listed in the third column.

<table>
<thead>
<tr>
<th>Product or File Extension</th>
<th>Supported first line entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avid DS .lut</td>
<td>AVID DS LUT</td>
</tr>
<tr>
<td>Autodesk LUT: followed by the number of channels and entries</td>
<td></td>
</tr>
<tr>
<td>IRIDAS 1D .itx</td>
<td>LUT_1D_SIZE</td>
</tr>
<tr>
<td>IRIDAS 3D .cube</td>
<td>LUT_3D_SIZE</td>
</tr>
<tr>
<td>Kodak KDM .3dl</td>
<td># IDENTIFICATION: 3DMODEL-3DLUT</td>
</tr>
<tr>
<td>LUTher .txt</td>
<td>#channels: c3</td>
</tr>
<tr>
<td>Mistika 3D .itx</td>
<td>LUT_3D_SIZE</td>
</tr>
</tbody>
</table>
Setting the Color Properties of Acquired Media

The LUT has to be installed before it can be applied to the media.

After the LUT is installed, the Source Settings dialog box will display it as an option in the Color Transformations list. This LUT is available to all sequences within the project.

Any changes made to these color files will be reflected in the viewer within this dialog box. Changes made in the source settings will be reflected when clips are dropped on the timeline. For clips already on the timeline prior to the changes, you will have to refresh the sequence. (Right-click the sequence and choose Refresh Sequence > Color Adapters).

Changing the settings for a master clip will also propagate these changes to subclips that were created prior to the changes. Similarly, any changes made to the subclips will be applied to the parent master clip.

To install an external LUT:
1. From the Settings tab, select and open the Color Management Settings.
2. Click Install LUT.
3. Browse for your file, select it and click Open to install it.

The LUT is now available in the list of color transformation in the Source settings. This LUT will be part of the project. All sequences in the current project will be able to access that LUT.

To apply an external LUT:
1. On the timeline, or in the bin, select the clip that you want to change, right-click and choose Source Settings.
2. Select the Color Encoding tab.
   The Source Settings dialog box displays with the viewer showing the first frame of the clip with the current color encoding.
3. Click the drop-down menu below the list of Color transformations.
   The installed LUT(s) will be listed at the bottom, prefixed with the word External.
4. You can apply more than one LUT to the media and change the order in which they are applied.

<table>
<thead>
<tr>
<th>Product or File Extension</th>
<th>Supported first line entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nucoda .lut</td>
<td>NUCODA_3D_CUBE 2</td>
</tr>
</tbody>
</table>
Using Color Decision Lists (CDLs)

A CDL (color decision list) is a simple color transformation format specified by the American Society of Cinematographers (ASC). It is a way to communicate color renditions between equipment and software from different manufacturers, using four critical parameters—slope, offset, power and saturation.

CDLs are used for the following reasons:

• to convey the intent of the Director of Photography (decisions made on-set)
• transferring primary color grading values from dailies or media preparation stations to the offline editing stations
• as a starting point for finishing stations to perform the final grading

Primary color grading can be performed as one of the pre-post functions on dailies systems and then passed on to the offline editing system. If the editing station uses MXF media, these colors are already applied. However, if the editor decides to use the original media, then he or she may want to read these values via the CDL and apply them to the master clips.

These CDL values are imported via an EDL or ALE (in the ASC_SOP and ASC_SAT parameters). They are stored with the clip metadata and can be exposed in the bin columns. When you export your sequence/segment as an AAF/ALE/EDL, these values are included and can be sent along to the effects specialist along with the associated media.

To enable the reading of CDL parameters:

1. Select the Settings tab.
2. Double-click Color Management from the list.
3. Select Use CDL values from ASC_SOP and ASC_SAT bin columns when available.
   Any values attached to the clip from the EDL/ALE will be applied as a color transformation and can be seen in the Source Settings for the clip.
4. Any clips with CDLs to which you link will automatically apply the CDL values. For clips that were already linked, you will need to open the Source Settings dialog and click the Auto button on the Color Encoding tab. Alternatively, you can select the CDL option from the Color Transformation list.

CDL values can be copied from one ASC_SOP bin column of a clip and applied to another. The changes will not be reflected on the receiving clip until you open the Source Settings dialog and click the Auto button.
Editing with Low-Resolution Proxy Media

AMA offers the advantage of allowing you to transcode material to a lower resolution at any stage of the process. Most production facilities transcode all their footage up front in order to get the best performance when previewing the footage for the editorial. Transcoding to DNxHD 36 is an acceptable quality for editing your sequences. However, if you plan on doing finishing work to your sequence, it's advisable to transcode your final sequence to DNxHD 145, DNxHD 220, or DNxHD 220x.

Media Composer provides configurable profiles (Dynamic Media Folders) to automate the transcoding of media from external drives. Furthermore, this can all be done in the background while building your sequence with the AMA-linked clips. Once the process is complete, you can link your sequence to the transcoded clips.

Refer to the appropriate topic below depending on whether you want to transcode all your footage, or if you prefer to create your sequence first and then transcode only the clips used in the sequence to low-res proxies.

Transcoding a Bin

The best way to transcode a bin is by using an automated background process set up via a Dynamic Media Folder. This procedure assumes that you have already created a bin with AMA-linked clips as recommended by “Considerations when Editing with File-Based Media” on page 30.

To transcode a bin using a DMF:
1. Open the bin containing the clips that you need to transcode.
2. Select Tools > Dynamic Media Folders.
3. Create a DMF that points to the folder where the media for these clips resides—see .
   This DMF may have already been created for another process. If so, you simply have to create a new profile for the transcode and attach it to the DMF as described below.
4. Click Profile Editor and create a profile for the transcode—see .

   For the Consolidate/Transcode options, select:
   - Create new clips
   - Apply color transformation (if color space adjustments were made on the AMA-linked clips and you want them to be applied when the new media is generated)
   - Apply reformatting option (if the AMA-linked clip was reframed/reformatted and you want it to be reflected when the new media is generated)
Color and reframing options do not have to be “baked in” to the media if you want the flexibility to make further transformations to the clips within the sequence. Any changes made to the proxies will be then be reflected when you relink to the source files.

5. Save the profile and name it accordingly.

6. Select the DMF and assign this newly created profile to it.

   You will be prompted to start the process. Click Yes to proceed.

   While the process is running, you will see an illuminated indicator in the Timeline. If you want to monitor this process, right-click on this indicator and choose Background Queue.

   This will open a window where you can see the copy, transcode or consolidate actions listed as processes in the queue. When an action has been completed on the folder where your media resides, you will see a green icon under the Acquire column of the DMF window.

   This means that new clips are available. Any clips that have been consolidated or transcoded will display as *.new files.

7. Click the Acquire icon at any time to update your bins with the newly-transcoded clips.

   Each time more clips are ready, the green icon will appear under the Acquire column in the Dynamic Media Folders window. You can click on this icon to keep updating your bin. The transcoded media is referenced by .new clips in your bin.

8. Move all the *.new clips to a new bin and rename the bin suitably. Separating the AMA and transcoded clips into different bins will allow you to link back to the source AMA clips more easily later in the editorial process.

9. Close the bin with the AMA-linked clips.

   Continue this process to transcode all media in other storage folders to low-res proxies.

**Transcoding a Sequence**

Some production houses may prefer to create the sequences with the AMA-linked clips first and then transcode only the clips used in the sequence to low-res proxies. This may be a more efficient process if you have enough space on your high-bandwidth storage to place your source camera files.

To transcode your sequence:

1. Right-click the sequence and select transcode.

   In the Consolidate/Transcode dialog box, select:

   - Create new sequence
   - Create new clips
   - Include handles
- Apply color transformation (if color space adjustments were made on the AMA-linked clips and you want them to be applied when the new media is generated)
- Apply reformatting option (if the AMA-linked clip was reframed/reformatted and you want it to be reflected when the new media is generated)

Color and reframing options do not have to be “baked in” to the media if you want the flexibility to make further transformations to the clips within the sequence. Any changes made to the proxies will be then be reflected when you relink to the source files.

When the sequence is transcoded, new media is created for each of the clips in the sequence. This media is referenced by new clips that will appear in your bin. Similarly, a new transcoded sequence will also appear in your bin.

2. Move all the *.new clips to a new bin and rename the bin suitably. Separating the AMA and transcoded clips into different bins will allow you to link back to the source AMA clips more easily later in the editorial process.

3. Close the bins with the AMA-linked clips.

4. Load the transcoded sequence onto the timeline for the fine-tune editing.

Once you start editing with the low-res proxies, any color adjustments you make to the proxy clips on the timeline are not transferred back to the original AMA clips. Therefore, apply source-side color adjustments directly to the proxy clips in the bin and then refresh the sequence in order to propagate the adjustments to the sequence. These adjustments will then be available when you link to the AMA clips. For procedures on how to refresh your sequence, see “Refreshing Sequences to Use Current Clip Attributes” in the Help.

For example, there may be a case where you need to reframe a certain segment of your sequence or do a pan and scan in order to follow the important action. Since the clips are already used within the sequence, you need to add the framing adapter on the proxy clips in the bin. You must then make sure to refresh your sequence in order to propagate the framing parameters to the sequence. This will allow you to do further adjustments on the framing box directly on the timeline in order to change it’s size and/or position from one frame to the next.

5. After the editing process is complete, you may want to switch back to the high-resolution sources before outputting your final sequence—see “Relinking to Source Media for Conform and Finishing” on page 67.

Relinking to Source Media for Conform and Finishing

If you built your sequence with AMA-linked clips and switched to lower-resolution clips for the editorial, you will need to switch back to the high-resolution sources if you want to output your final sequence at a better resolution.
To relink to the original media:

1. Close the bin(s) with the transcoded clips and open the bin(s) with the AMA-linked clips.
2. Select the edited sequence, press the Shift key and select all the AMA-linked master clips in all the open bins.
3. Right-click on the edited sequence and select Relink from the menu.
4. In the Relink dialog box, choose:
   - Relink selected items to: Selected items in ALL open bins
   - Create new sequence.
5. Set any other options as necessary and click OK to relink.
   
A new relinked sequence containing the AMA-linked clips will appear in the bin.
6. Load this relinked sequence onto the timeline for the conform.
   
At this point, you can continue the finishing process with the AMA-linked clips, or you can transcode your sequence to an HD resolution that is suitable for output.
7. For the transcode, right-click the sequence and transcode to the online resolution including handles. This will transcode only the required media and create a new sequence with links to the newly transcoded clips. You can then load this transcoded sequence onto the timeline for the final stages.

### Linking to MXF Media

Your facility may have a pipeline which creates processed or aligned MXF files using a dailies application. Avid recommends that the dailies system generate an AAF file of this media. The AAF can be imported into the Avid to generate bins with master clips that point to the MXF media. In the case of an AAF, the media will come online automatically.

If an AAF is not available, then you can use the Avid Media Tool to create clips from the MXF media.

Keeping media from the same source (at all available resolutions) in the same folder, will also ease the file maintenance and facilitate the reimport process in the event that a different resolution of a clip is required.
To link to MXF media via AAF:
1. Make sure that all your transcoded MXF files are located in the appropriate Avid MediaFiles folder (drive letter:\Avid MediaFiles\MXF\).
2. Open the bin in which you want to create the master clips.
3. Right-click in the bin, and select Import (or simply drag and drop your clips into the bin).
4. Locate the AAF file that you want to import and click Open.
   If you imported an AAF, all clips in the bin will automatically be linked to the corresponding MXF media.
5. The master clips will appear in the bin.

To link to MXF media via the Media Tool:
1. Select Tools > Media tool.
2. Select the media drives where the MXF files are located.
3. Sort the clips by creation date and select the clips that you need.
4. Drag these clips into your bin.
5. The master clips will appear in the bin.

Merging Additional Metadata for Clips

You can import additional metadata for your media—such as information from a 3rd-party application that processed the media—and merge it with existing master clips in a bin. This metadata will be imported as long as it follows the Avid conventions for the bin column data.

To merge additional metadata into a bin:
1. Select the master clips for which you have additional metadata to merge.
2. Right-click on one of the clips, and select Import.
3. Locate the ALE file holding the metadata that you want to import, and click Open.
4. To select options for combining events on import, click Options to open the Import Settings dialog box.
5. From the Shot Log tab, you must select Merge events with known master clips.
   When this option is selected, your Avid editing application merges information in the shot log onto selected master clips based on the matching tape name or source file name. This must be an exact match and so should the START and END timecodes.
6. Click OK to close the Import Settings dialog box and return to the Select Files to Import dialog box.
7. Select the source file from the list and click the Open button. When your Avid editing application finishes importing the file, the clips (or new metadata for the clips) will appear in the selected bin.

**Rendering Effects**

Any effects applied to clips on the timeline will use the project color space (Rec 709) when they are processed for real-time playback. All effects-processing for playback is done on the fly, in some cases, dropping frames or slowing down as necessary to display your color-corrected output at high quality for evaluation purposes. Playback is not cached to RAM. You can choose to invoke the Render option and cache the new media to disk storage in order to play your sequence smoothly. Any precomputes rendered to the disk storage will also be generated using the project color space with a maximum bit depth of 10-bit.

**Viewing Sequences with Mask Regions**

You can specify mask margins on the output frame to view a master with a different aspect ratio than the project setting. This provides many useful features especially for those dealing with film distribution (e.g. widescreen mode for DVD).

The project Format tab allows you to select from various aspect ratio presets. In the viewers, this selected aspect ratio will mask out (with a gray or black background) any area of the image that is not inside the specified rectangle. This is for viewing purposes only. For example, if you apply a dissolve or an effect, the mask is not processed. Your viewer simply displays the masked area as in the example below.
At this time, the mask regions are not applied when the sequence is exported to file. For output to tape, however, the mask margins can be applied if you enable the mask region in the output tool.

To set the mask margins for the project:
1. In the Project dialog box, select the Format tab.
2. Click the Mask Margins button.
   The Target Settings dialog displays.
3. Select one of the mask presets or set the margins manually by selecting the appropriate percentage of the image to be occluded.

**To display the mask area in the viewers:**

1. Right-click in the source or record viewer and select Target Mask.
2. Choose from one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Mask</td>
<td>Does not display masked region.</td>
</tr>
<tr>
<td>Gray Mask</td>
<td>Displays masked region with a translucent gray to allow you to view the full image.</td>
</tr>
<tr>
<td>Black Mask</td>
<td>Blacks out the masked region to display the image as it would appear when output.</td>
</tr>
</tbody>
</table>

The viewer updates accordingly.

To see the same results on an external monitor, you will need to open the Output Tool to set the Target Mask option.
Source viewer showing full image with gray mask

Record viewer showing reformatted image with black mask
Exporting Sequences to File

The media formats for which you can output media include the following—QuickTime (MOV, AVI), Windows Media (WMV), MPEG, HDV, DV Stream, single-frame graphics (PNG, TIFF, BMP, etc.).

Before you output your sequence, refer to “Preparing to Export a Sequence” in the Help for your editing application.

To select the section for export:

1. Render any AMA-linked clips and effects in your sequence.
2. Identify the portion of the sequence that you want to export.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To export specific tracks in a clip or sequence:</td>
<td>Enable the tracks in the Track Selector panel, and disable all others. Ensure that Use Enabled Tracks is selected in the Export Settings dialog box.</td>
</tr>
<tr>
<td>To export a single-frame graphic:</td>
<td>Mark an IN point to export the marked frame from a bin or a monitor, or move the position indicator to the frame you want to export. Ensure that Use Marks is selected and that Sequential Files is deselected in the Export Settings dialog box.</td>
</tr>
<tr>
<td>To export part of a clip or sequence:</td>
<td>Mark IN and OUT points to export the marked range from a bin or a monitor. If you mark an IN point and no OUT point, your Avid editing application exports from the IN point to the end of the clip or sequence. Ensure that Use Marks is selected in the Export Settings dialog box.</td>
</tr>
<tr>
<td>To export the entire clip or sequence:</td>
<td>Make sure the topmost track is monitored. Ensure that Use Enabled Tracks and Use Marks are deselected in the Export Settings dialog box.</td>
</tr>
</tbody>
</table>

For information on setting options in the Export Settings dialog box, see the Help.

3. Select the clip or sequence by doing one of the following:
   - Click the monitor that displays the clip or sequence you want to export.
   - Click the clip or sequence in a bin. Ctrl+click (Windows) or Shift+click (Macintosh) to select multiple clips or sequences.

4. Do one of the following:
Exporting Sequences to File

- Select File > Export.
- Right-click the clip or sequence, and then select Export.

The Export As dialog box opens with a default file name in the File name text box (Windows) or the Save As text box (Macintosh), based on the file type.

5. Click the Export Setting menu, and select one of the predetermined settings.

This menu lists the possible formats in which you can export your selection. It also determines the type of file(s) that will be exported. For example, if you select Sorenson Squeeze, then a QuickTime reference file will be exported.

Here are the possible options when exporting to media files:

![If none of these meet your needs, then select Untitled and click Options to create a customized export setting.]

<table>
<thead>
<tr>
<th>Export Setting</th>
<th>Export Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avid 3D Audio</td>
<td>WAV</td>
</tr>
<tr>
<td>Avid Pro Tools LE (Mbox-Ref)</td>
<td>MOV</td>
</tr>
<tr>
<td>Fast-Export QuickTime NTSC</td>
<td>MOV</td>
</tr>
<tr>
<td>Fast-Export QuickTime PAL</td>
<td>MOV</td>
</tr>
<tr>
<td>Macintosh Image NTSC</td>
<td>TIF</td>
</tr>
<tr>
<td>Macintosh Image PAL</td>
<td>TIF</td>
</tr>
<tr>
<td>Make New - QuickTime Reference</td>
<td>MOV</td>
</tr>
<tr>
<td>Pro Tools QuickTime (ref)</td>
<td>MOV</td>
</tr>
<tr>
<td>QuickTime Reference</td>
<td>MOV</td>
</tr>
<tr>
<td>QuickTime Reference DV Codec</td>
<td>MOV</td>
</tr>
<tr>
<td>Send to QT Movie</td>
<td>MOV</td>
</tr>
<tr>
<td>Sorenson Squeeze</td>
<td>MOV</td>
</tr>
<tr>
<td>Sorenson Squeeze - Encode for DVD</td>
<td>MOV</td>
</tr>
<tr>
<td>Windows Image NTSC</td>
<td>BMP</td>
</tr>
<tr>
<td>Windows Image PAL</td>
<td>BMP</td>
</tr>
</tbody>
</table>

6. If you want to view or modify the current Export Setting, click Options.
The Export Settings dialog box opens.

The export settings for some formats can be complicated. In some cases, options in the Export Settings dialog box open additional dialog boxes with further options. If you are modifying the Export settings, consult “Common Export Settings” in the Help.

Close the Export Settings dialog box to return to the Export As dialog box.

7. Select the destination folder for the file.
8. Enter a Filename for the selection that will be exported.
   The extension will depend on the Export Setting that you chose.
9. Click Save.
   Your Avid editing application exports the file.
   If you abort the Export while it is in progress, any files that were created, will be deleted.

Exporting Sequences to External Applications

If you need to apply custom effects or if you intend to finish your project on another application such as Avid DS for color grading, effects and other finishing, then you can export your sequence to a project data file. Your Avid editing application allows you to export part, or all your sequence to an AAF/AFE/EDL along with the associated video and audio media.
To select the section for export:

1. Identify the portion that you want to export.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To export specific tracks in a clip or sequence:</td>
<td>Enable the tracks in the Track Selector panel, and disable all others.</td>
</tr>
<tr>
<td></td>
<td>Ensure that Use Enabled Tracks is selected in the Export Settings dialog box.</td>
</tr>
<tr>
<td>To export a single-frame graphic:</td>
<td>Mark an IN point to export the marked frame from a bin or a monitor, or move the position indicator to the frame you want to export.</td>
</tr>
<tr>
<td></td>
<td>Ensure that Use Marks is selected and that Sequential Files is deselected in the Export Settings dialog box.</td>
</tr>
<tr>
<td>To export part of a clip or sequence:</td>
<td>Mark IN and OUT points to export the marked range from a bin or a monitor. If you mark an IN point and no OUT point, your Avid editing application exports from the IN point to the end of the clip or sequence.</td>
</tr>
<tr>
<td></td>
<td>Ensure that Use Marks is selected in the Export Settings dialog box.</td>
</tr>
<tr>
<td>To export the entire clip or sequence:</td>
<td>Make sure the topmost track is monitored.</td>
</tr>
<tr>
<td></td>
<td>Ensure that Use Enabled Tracks and Use Marks are deselected in the Export Settings dialog box.</td>
</tr>
</tbody>
</table>

For information on setting options in the Export Settings dialog box, see the Help.

2. Select the clip or sequence by doing one of the following:
   - Click the monitor that displays the clip or sequence you want to export.
   - Click the clip or sequence in a bin. Ctrl+click (Windows) or Shift+click (Macintosh) to select multiple clips or sequences.

3. Do one of the following:
   - Select File > Export.
   - Right-click the clip or sequence, and then select Export.

   The Export As dialog box opens with a default file name in the File name text box (Windows) or the Save As text box (Macintosh), based on the file type.

4. Click the Export Setting menu, and select one of the predetermined settings.

   This menu lists the possible formats in which you can export your selection. It also determines the type of file(s) that will be exported. For example, if you select Export to Pro Tools, then an AAF metadata file will be exported.

   Here are the possible options:
If none of these meet your needs, then select Untitled and click Options to create a customized export setting.

<table>
<thead>
<tr>
<th>Export Setting</th>
<th>Export Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>AudioVision</td>
<td>AAF</td>
</tr>
<tr>
<td>Avid 3D Video</td>
<td>AAF</td>
</tr>
<tr>
<td>Avid Pro Tools LE (002)</td>
<td>AAF</td>
</tr>
<tr>
<td>Avid Pro Tools LE (Mbox-AAF)</td>
<td>AAF</td>
</tr>
<tr>
<td>Avid DS</td>
<td>AFE</td>
</tr>
<tr>
<td>Consolidate Audio to Folder</td>
<td>AAF</td>
</tr>
<tr>
<td>Consolidate-Embed Audio Only</td>
<td>OMF</td>
</tr>
<tr>
<td>Consolidate-Link Audio and Video</td>
<td>AAF</td>
</tr>
<tr>
<td>Export to Pro Tools</td>
<td>AAF</td>
</tr>
<tr>
<td>Link to Audio Only</td>
<td>AAF</td>
</tr>
<tr>
<td>Link to Audio and Video</td>
<td>AAF</td>
</tr>
<tr>
<td>Link to Audio and Video Mixdown</td>
<td>AAF</td>
</tr>
</tbody>
</table>

5. If you want to view or modify the current Export Setting, click Options. The Export Settings dialog box opens.

   The export settings for some formats can be complicated. In some cases, options in the Export Settings dialog box open additional dialog boxes with further options. If you are modifying the Export settings, consult “Common Export Settings” in the Help.

   Close the Export Settings dialog box to return to the Export As dialog box.

6. Select the destination folder for the file.

7. Enter a Filename for the selection that will be exported.

   The extension will depend on the Export Setting that you chose.

8. Click Save.

   Your Avid editing application exports the file.

   If you abort the Export while it is in progress, any files that were created, will be deleted.
Acquisition of File-Based Media (AMA)

You can link, import, or export clips and sequences from many third-party volumes or third-party files to and from the Avid editing system. You can manipulate and edit this media as you would any other clip or sequence.

File-based media can be acquired from a third-party device (a camera, reader, or drive), from a CD or DVD, from a folder on your system, or from a virtual volume (a server connected to your system). To move the media into your Avid editing system, you have the option to use the AMA method (Avid Media Access) which links the file based media directly into a bin through an AMA plug-in, or you can use the non-AMA method which imports the media onto your system. When you work with high-resolution media, the AMA method is the preferred and the faster method.

AMA linking also allows for more metadata to be brought into the bin which gives you more information about the media. For example, essence marks (or markers) associated with the clip are automatically brought into your bin.

For information on importing and exporting media, see “Importing Files” on page 393 and “Exporting Frames, Clips, or Sequences” on page 1145.

Before you begin working with AMA, make sure you have done the following:

- Go to avid.com/ama to make sure you download the latest plug-in for your specific third-party device.
- If you are using an XDCAM, XDCAM EX or a P2 device, make sure you have the appropriate drivers installed. See your third-party documentation for information on installing drivers.
- Connect the third-party device according to the documentation supplied with the device.

The Avid Media Access (AMA) Workflow

Avid Media Access (AMA) is a plug-in architecture that lets you link directly to clips on an external third-party device. The device can be a camera, a card reader, an optical disk, a virtual volume. AMA lets you be more productive by browsing and editing directly from the device or volume.
There are two ways of browsing and editing this media:

- Manually browse through the media on the third-party device, and link to selected media to create master clips in your bin, or
- Move all the media from the third-party device to an Avid dynamic media folder where you have set up an automated process to create the master clips.

Typical media management functions (e.g. deletes, transcodes, consolidates) apply to all AMA-linked clips in the same robust manner as they do for managed MXF Avid-compliant OPAtom files. All media, whether captured, imported or linked by AMA, will be displayed in a single window in the Media Tool.

AMA and dynamic media folders are the quickest method by which you can automate the acquisition of footage, and significantly enhance your production workflow when working with media in popular digital formats.

With the use of dynamic media folders, you can organize your files and assign automated actions to a “watched” folder system. These actions run in the background, allowing you to keep working while files are being ingested into the application. The actions include copy, consolidate and transcode—see “Creating Dynamic Media Folders” on page 86.

Before you begin editing, set up media service profiles to run automated media acquisition actions on the specific drives/folders where the original media is located. Any files placed in these folders will be processed and managed in the background.

The illustration below shows how you can automate the acquisition of file-based media in the background so that you can continue editing your sequence without interruption.
1. You can begin the editorial by linking directly to the media on an external device. In the meantime, the pre-configured Dynamic Media Folder (DMF) profiles will automatically copy the files from the external device to an AMA media folder of your choice on a local or shared storage. These folders will be managed and indexed by the application.

2. Master clips will be created for all the copied files and added to a 'staging' area so as not to cause interruptions each time a new file is acquired. Any related audio and video files will be auto-synced. Similarly, any related clips coming from multiple cameras will be auto-grouped.

3. Depending on how your dynamic media folders were configured, some specific file formats will be consolidated and/or transcoded to MXF proxy media. This media will be placed in the Avid MediaFiles folder and separate master clips (*.new) will be created in the bin for this media.
4. When files are ready to be pulled into a bin, you will be notified by a green light to the right of the audio meters in the timeline. Through the Dynamic Media Folders dialog, you can request a bin update which will pull the clips into a bin.

Any AMA-linked clips already on the timeline will automatically point to the new location of the media. Similarly, if any files were transcoded/consolidated, and you selected the “relink” option in the DMF dialog, the master clips will automatically point to the new media files.

5. If you want to work with transcoded media, on the other hand, you need to manually relink your sequence to the new master clips in the bin.

In an Interplay environment, the relink can be done automatically. See “Enabling Dynamic Relink” in the online help.

Considerations and Limitations for AMA

Footage from the Sony XA VC and ARRI ALEXA cameras can be recorded directly to MXF. Since Avid will have native HD codecs for these MXF formats, editors can link to or import this media in Media Composer. Working with the MXF media provides better performance for playback and rendering.

Other high resolution raw file formats that are not supported by Media Composer can be transcoded to MXF by Avid MetaFuze or other third-party applications.

The following limitations apply:

- When the AMA setting is activated, the non-AMA method does not appear in the File menu. Deactivate the AMA setting to display the File > Import P2 (and Import XDCAM Proxy) option. The AMA setting is on by default.

- Windows UNC (Universal Naming Convention) paths are supported with AMA media. You can move your AMA bins from a Windows system to a Macintosh system and from a Macintosh system to a Windows system. The media files need to reside in the same shared location when you move the bins to and from different operating systems.

- Do not AMA link to a volume or file if the file path name has an illegal character. AMA clips display offline if the file path name you are linking to contains illegal characters, including < > : “ / | ? *, for Windows and : for Macintosh.

- You can create stereo clips from AMA-linked media. Refer to Avid Stereoscopic 3D Editing Workflow Guide.

- Interplay and Interplay Sphere users can use the dynamic relink capability to view the best available media for AMA-linked clips. Refer to “Using Dynamic Relink with Interplay Sphere Editing Systems” on page 49 or the Avid Interplay Sphere Remote News Editing Workflow Guide.
When you render an audio effect on an AMA media clip, all audio media files are written as PCM (MXF), regardless of what you set for the audio file format.

Avid does not support MultiCamera editing with AMA clips.

You should not mix workflows. Either use the AMA method or use the traditional import/batch import method.

**Viewing Installed AMA Plug-ins**

Once you download and install a third-party plug-in from avid.com/ama, you can enter a console command to view a list and the version number of the plug-ins installed on your system.

**To display the list of installed AMA plugins:**

1. Select Tools > Console.
2. In the command entry text box, type: `AMA_ListPlugins`
3. Press Enter (Windows) or Return (Macintosh).

   `AMA_ListPlugins` displays a list of the plugins installed on your system.

**Selecting the AMA Settings**

You can set options in the AMA Settings dialog box to turn AMA on or off (on by default), to automatically mount your volumes, to customize your bin, and to set audio channel linking options.

**To set up AMA:**

1. In the Project window, click the Settings tab.
2. Double-click AMA.

   The AMA Settings dialog box appears.
3. Click the Volume Mounting tab.

4. If you want the system to automatically scan drives (volumes) every time, select the option “When mounting previously mounted volumes, do not check for modifications to the volume.” This option is off by default.

5. If you remount a volume, deselect the option “When mounting previously mounted volumes, do not check for modifications to the volume,” and the system checks the modification date of the device or drive against the last time the clips were linked. If the date is the same, the clips come back online. If the date is different, the system links the clips again, and links any new clips added to the volume. This option is off by default.

If you restart your Avid editing application, the system automatically rescans the drives regardless of the options you’ve selected.

6. To customize your bin, click the Bins tab.

By default, the system links your clips into a new bin using the same name as your project name. If you want to change the bin name or want to use an already existing bin, you can make these changes in the Bins tab.

For more information on Bins options, see “AMA Settings: Bins Tab” on page 46.

Depending on your AMA Settings, every time you insert a card into a reader, the system creates a new bin whether the same card or device has been previously inserted or not.

7. To map source audio channels to multichannel or mono tracks in your clips, click the Link Options tab, and then click Edit.
Manually Copying File-Based Media to a FireWire or Network Drive

The Set Multichannel Audio dialog box opens. For information on setting multichannel audio options, see “Using XDCAM Multiple Resolution Clips with AMA” on page 106.

8. Click OK.

Manually Copying File-Based Media to a FireWire or Network Drive

After you’ve connected your camera or other portable storage to the editing system, you can copy the media to a FireWire drive or a network drive and then eject the camera or disk.

Alternatively, you can use Dynamic Media Folders (DMF) and profiles to carry out this copy function in the background—see “Creating Dynamic Media Folders” on page 86.

You can work with media on a card/disk or work with media on another drive, but you cannot work with media that is stored in both places simultaneously. To avoid the problem, eject the card or disk after you copy the media files to the other drive.

To manually copy the card or disk media to another drive:

1. On the local or shared system drive, set up a folder for each card or disk you want to copy. Follow the recommendations outlined in “Organizing your File-Based Media” on page 34.

2. Give each folder a unique name that identifies the card or disk. The name does not have to be the same as the actual card or disk name.

3. Navigate to the actual card or disk and select the folder with the media.

4. Do one of the following:
   - Copy and paste the contents of the card or disk media folder to the system folder.
   - Click the card or disk folder and drag it to the system folder.

5. Eject the card or disk.

Dragging and Dropping File-based Media Directly to a Bin

You can drag and drop file-based media directly to a bin.

To drag and drop files directly into a bin:

1. Navigate to the folder that contains the file based media.

2. Select the files you want to drag to the bin.
3. Alt + drag (Windows) or Option + drag (Macintosh) the files to the bin.

The files appear in the bin as AMA linked files. These are also managed files and appear in the Media Tool.

Creating Dynamic Media Folders

Dynamic Media Folders (DMFs) are user-created folders that allow you to work more efficiently with file-based media. DMFs allow you to manage and process media even when the editing application is not running. For example, you can create a DMF where the media from a digital camera or removable drive can be moved off the camera and placed in the DMF, allowing the production team to quickly take the device back out to the field. A profile associated with that DMF can be setup to have these files AMA-link into a particular bin.

AMA media is now managed. Therefore the AMA media will now appear in the Media Tool and can be checked into Interplay.

You can also create DMFs that are set up to perform time consuming tasks such as copying, transcoding or consolidating. You can create a DMF folder that copies all files placed in the DMF to a specified location. You can also set up a DMF to transcode or consolidate any file that is placed in the folder to a specified resolution. These processes occur in the background.

The basic workflow for using DMFs is the following.

• In the Dynamic Media Folders window, create a DMF folder. This folder can reside locally or on shared storage.
• Create a new profile or assign an existing profile to the DMF folder. This profile is where you specify the actions you want performed on any files that get added to the DMF folder.
• An indicator on the Timeline will let you know when files have been added to a DMF folder. Access the DMF window and choose to place the files from the DMF into the appropriate bin.

To create a Dynamic Media Folder:


   The Dynamic Media Folders window opens.
2. Create a new folder by clicking the + icon in the Dynamic Media Folders window. The Select Folder window opens.
3. Navigate to the folder on which you want to perform the action and click Choose. A DMF is added to the list.
4. Click the Profile Editor button to create a profile that you want associated with the DMF. The Profile Editor opens.
5. Click the Menu bars to open the default profile summary and default AMA Settings and Actions.
6. Select AMA Settings options as described in the following table.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMA Plugin</td>
<td>Link Using</td>
<td>Select which Plug-in you want the editing application to use when performing AMA links for the files added to the selected DMF folder. If you are linking to Volumes, Avid recommends you select the Autodetect AMA Plug-in.</td>
</tr>
<tr>
<td>Bins</td>
<td>Use active bin</td>
<td>When this option is selected, your Avid editing application uses the currently active bin to store clips linked using AMA.</td>
</tr>
</tbody>
</table>
To add actions to be performed on files found in the DMF such as copy, transcode, consolidate or check into Interplay, click the Actions + to add an action.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Create a new bin</td>
<td>When this option is selected, your Avid editing application creates a new bin to store clips linked using AMA and controls the bin name. This is the default option.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default bin naming convention: uses the project name for the bin (bin name followed by a consecutive number).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Volume name: the name or label of the volume (for example D:).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Specify bin name: lets you enter a new bin name.</td>
</tr>
<tr>
<td>Link</td>
<td>Multichannel Audio</td>
<td>Select this option if you want to assign audio tracks to specific channels in your linked media, up to a maximum of 16 audio channels for the clips in your bins. This allows you to specify which source channels are treated as mono or multichannel audio tracks in your project, rather than having to modify the clips in your bin after you link to the AMA media.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click Edit to open the Multiple Mixes dialog box, which allows you to map audio tracks to channels.</td>
</tr>
<tr>
<td></td>
<td>Audio Start-Time Option (for Broadcast Wave)</td>
<td>Select this option to set the audio Project Rate for Broadcast Wave files.</td>
</tr>
</tbody>
</table>

7. To add actions to be performed on files found in the DMF such as copy, transcode, consolidate or check into Interplay, click the Actions + to add an action.
8. Click the Menu button on a row to access the desired copying, consolidating and/or transcodung actions you want to be performed on the files. Choose from the following options:

<table>
<thead>
<tr>
<th>Action</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy to Folder</td>
<td>Copy to:</td>
<td>Click the Set button to choose the location where you want the files copied to.</td>
</tr>
<tr>
<td></td>
<td>Auto Relink when complete</td>
<td>Files are automatically relinked when the copy is completed.</td>
</tr>
<tr>
<td></td>
<td>Checkin to Interplay</td>
<td>Checks in assets to Interplay. When you select this option, also select the “Auto Relink when complete” option.</td>
</tr>
<tr>
<td>Consolidate</td>
<td>Skip media files already on the target drive</td>
<td>Select to bypass files if some related media files are already located on the target drive.</td>
</tr>
<tr>
<td></td>
<td>Relink selected clips to target drive before skipping</td>
<td>Select to ensure that all selected clips are linked to media on the target drive.</td>
</tr>
<tr>
<td></td>
<td>Convert Audio Sample Rate</td>
<td>Select this option to convert the sample rate to 32 kHz, 44.1kHz, or 48 kHz.</td>
</tr>
<tr>
<td></td>
<td>Convert Audio Bit Depth</td>
<td>Select this option to convert the Bit Depth to 16 Bit or 24 Bit.</td>
</tr>
</tbody>
</table>
### Creating Dynamic Media Folders

<table>
<thead>
<tr>
<th>Action</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Drive</td>
<td>Audio Drive</td>
<td>Select the applicable drives.</td>
</tr>
<tr>
<td>Transcode</td>
<td>Transcode Video Resolution</td>
<td>Select the applicable Project type, Color Space, Raster and Codec you want to transcode to.</td>
</tr>
<tr>
<td></td>
<td>Apply Reformatting option</td>
<td>Transcodes the media and applies any framing and reformatting options that have been set on the master clips.</td>
</tr>
<tr>
<td></td>
<td>(compatibility mode)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Apply color transformations</td>
<td>Transcodes the media with any color transformations (color space, LUTs, CDLs) that have been applied to the master clips. If these options are not selected, then the reformatting options, framing, and color transformations are not applied when the media is transcoded. The information however, is still retained in the clip metadata, and will be used with the transcoded media when the clip is dropped on the Timeline.</td>
</tr>
<tr>
<td></td>
<td>Convert Audio Sample Rate</td>
<td>Select this option to convert the sample rate to 32 kHz, 44.1kHz, or 48 kHz.</td>
</tr>
<tr>
<td></td>
<td>Convert Audio Bit Depth</td>
<td>Select this option to convert the Bit Depth to 16 Bit or 24 Bit.</td>
</tr>
<tr>
<td></td>
<td>Convert Audio Format</td>
<td>Select either OMF (WAVE), OMF(AIFF-C), or MXF (PCM) audio format.</td>
</tr>
</tbody>
</table>
9. You can also reorder the actions by priority by dragging one above or below the other.
10. Click Save to save the Profile.
11. Name the Profile and click OK.
12. Assign the profile to the DMF by choosing the profile from the drop down list.
13. Select Enable in the Dynamic Media Folders window to make sure that any files added to the Dynamic Media folder will have the actions set by the associated Profile.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Drive</td>
<td>Select the applicable drives.</td>
</tr>
<tr>
<td>Audio Drive</td>
<td></td>
</tr>
</tbody>
</table>

When files are placed in a Dynamic Media Folder, you will see a progress indicator in the Timeline. If the progress indicator includes a a solid green dot in the center, new DMF assets are available. See table below for a description of the progress indicator status.

<table>
<thead>
<tr>
<th>Button</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Solid green dot]</td>
<td>You can access the DMF folder to ingest the assets into your bin.</td>
<td></td>
</tr>
<tr>
<td>![Spinning with or without a green center dot]</td>
<td>This indicates that background processing is in progress.</td>
<td></td>
</tr>
<tr>
<td>![Yellow]</td>
<td>This indicates there is an error. Right-click the progress indicator and select Generate Error Report in Console. The progress icon will remain yellow until you generate an error report.</td>
<td></td>
</tr>
<tr>
<td>![Not spinning and no center dot]</td>
<td>This indicates that no background processing is in progress and there are no DMF assets to ingest.</td>
<td></td>
</tr>
</tbody>
</table>
14. Right+click the progress indicator and select Dynamic Media Folders.
   The Dynamic Media Folders window opens.

15. Click the green icon in the Acquire column.
   The new assets will populate the editing application Bin according to the Bin setting you chose in the Profile Editor. Any clips that have been consolidated or transcoded will also populate the bin as .new files. If some clips are still being processed, they will populate the bin as offline. When they are ready, the Acquire icon will redisplay next to the DMF.
   You can monitor the background progress of these files by selecting Tools > Background Queue.

   You can a cancel job by clicking on the x next to the item in the queue. If you want to cancel all jobs in progress, you can stop the Avid Background Services.

**Linking Media with AMA**

The editing application will automatically link clips on a volume when you connect to your third-party device. You can also use the File > AMA Link option to manually link to a volume or file.
AMA media is managed. AMA managed media means that the AMA media is tracked. The AMA media is associated with .pmr and .mdb files. Therefore the AMA media will appear in the Media Tool and can be checked into Interplay.

AMA linking lets you point to media on a device or point to the media directly on your system. The media physically resides on your system or it can reside on an external device. The media points to the most recent source. For example, if you link the clips to a virtual volume on your desktop, the drive column displays the desktop as the location where the clips are linked to. If you then insert a card into a reader with the same media, the clips point to the media on the card. If you remove the card, the clips point to the media on the card and the clips appear offline. The card being the most recent source. Once the card is reinserted, the clips in the bin appear online. See also, “Using Virtual Volumes” on page 102 and “Virtual Volumes and AMA Bins” on page 103.

For optimum viewing and playing, Avid recommends a single clip length should not exceed more than 12 hours.

The decompose option from the Clip menu is not available with AMA. You do not need to decompose clips when you use the AMA Link.

To automatically link clips from a third-party device:

1. Connect the drive, card reader or device to your computer as described in the third-party device documentation.

   The system scans the device and links the clips into the default bin and with the default multichannel audio track formats (based on the AMA settings). A link icon appears next to the clip.

   To change the default bin, bin name, or audio track format, from the Project window double-click AMA Settings and select options from the Bins and Link Options tabs. For more information, see “AMA Settings” on page 46 and “Using XDCAM Multiple Resolution Clips with AMA” on page 106.

To link clips from a virtual volume with AMA:

1. Select File > AMA Link.

   The Open dialog box opens.
2. Navigate to the folder that contains your file-based media. For P2, navigate one level above the Contents folder. For XDCAM disks, navigate to one level above the Clip folder. For XDCAM EX, navigate to one level above the BPAV folder. For RED, navigate to the root directory of the RED card. For GFCAM, navigate to the root directory of the GFPAK. For QuickTime, navigate to the QuickTime folder that holds the QuickTime files.

Depending if you are using an existing bin or creating a new bin, the Bin Selection dialog box opens.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Bin Based On Selected Folder</td>
<td>Places all linked clips into one default bin.</td>
</tr>
<tr>
<td>Single Bin Named</td>
<td>Lets you create a new bin and type in a new bin name.</td>
</tr>
<tr>
<td>Bin(s) Based on Current AMA Setting</td>
<td>Places the clips in the bin(s) you set up in the AMA Settings Bins tab.</td>
</tr>
<tr>
<td>Bin(s) Based on Subfolders</td>
<td>Places the clips in bin(s) based on their subfolders.</td>
</tr>
<tr>
<td>Top Bin Window</td>
<td>Places the clips in the active bin.</td>
</tr>
</tbody>
</table>

4. Click OK.

The clips appear in the bin or bins depending on the options you selected. A link icon appears next to the clips.

**To link clips from a file with AMA:**

1. Select File > AMA Link.
   
   You can also right-click a bin and select AMA Link.

2. The Open dialog box opens.

3. Navigate to and select the files you want to link to. Ctrl+click or Shift+click to select multiple files.

4. From the Files of Type menu either select Autodetect AMA Plug-in or select the plug-in from the list. Audodetect will detect the appropriate plug-in from the list of installed plug-ins.
5. Click Open.

The clips appear in the active bin with the default multichannel audio track formats (based on the AMA settings). A link icon appears next to the clips.

If the system cannot link a file, an error message displays informing you to open the Console window for more information about the file(s) in error.

If you move the clip from the original drive to another drive on your system, the clip displays as offline in your bin.

If you move a source file from one location to another and then back to the original location, you might need to refresh the bin to redisplay the clip. Close and reopen the bin to refresh the bin.

Relinking to AMA-Linked QuickTime Files

After you link Quicktime files into your sequence, you have the option to make changes (in a third party applications, such as Adobe After Effects) to that file. If you change the filename or change the location of the file, the best way to link that clip back into your sequence is through the relink option. Relinking to an AMA file allows you to link to a different file. This process only works if the targeted file is compatible with the old file, for example the file has the same duration, edit rate or number of tracks.

This feature is helpful when you have a group of linked clips that were moved to a different folder or drive. You can relink the clips to the new location. You can also use this feature to toggle between different versions of a QuickTime movie, for example a low-resolution version of the movie is myMovie_DV.mov and the high-resolution version of the movie is myMovie_1to1.mov. You can relink to both of these versions, to see which clip works better in your sequence.

At this time, Relink to AMA File(s) is only available with AMA QuickTime files.

To relink to AMA file(s):

1. Select the file(s) you want to relink by doing one of the following:
   - Click a single file
   - Shift+click to select multiple adjacent files
   - Ctrl+click (Windows) or Command+click (Macintosh) to select multiple nonadjacent files
2. Right-click and select Relink to AMA File(s).
   - The Select file(s) to relink AMA clip dialog box opens asking you to locate the new file(s).
3. Locate the folder where the files exist.
4. Click OK.
The clips appear linked in the bin. If all the clips you wanted to relink to do not reside in the selected folder, you will receive a dialog indicating how many files were not relinked. Open the Console window to see the name of the file or files that were not relinked.

*If the new file is not compatible with the clip in the bin (it does not have the same duration, edit rate or number of tracks), the clip in the bin retains its original link.*

**Spanned Clips**

Spanned clips are clips that extend from one card to another. Avid supports working with spanned clips with some third party devices such as P2, AVCHD, Canon, and XDCAM EX.

The following illustration shows how clips can span multiple cards.

![Example of spanned clips. The white rectangles represent P2 cards and the gray rectangles represent clips. The first and third clips span multiple cards.](image-url)
When you work with spanned clips, consider the following:

- If you remove a card that contains a spanned clip, for example Card 2 in the above example, and you try to play Clip 1, it plays until it reaches the portion of the clip that resides on Card 2. Media Offline appears until you reach the media on Card 3. Avid recommends that you do not place another card in the removed card’s place unless you remove all the cards that contain the spanned clip (Cards 1 and 3 in this example).

- You can mix cards that contain spanned and unspanned master clips. However, if you eject a card which contains a chunk of a spanned clip and insert another card, the master clips in the newly inserted card are not visible in the Media Tool but the media files are visible. To work around this, remove all the cards which contain chunks of the spanned clip and choose File > Unmount followed by File > Mount All (non-AMA method). All the master clips are visible.

- P2 and XDCAM EX spanned media covers multiple drives, but the bin displays only one drive letter. The drive letter in the bin might be any of the drives, but is usually the highest lettered drive where the media exists.

- If necessary, copy all spanned clips to another drive to ensure a clip’s integrity before you swap out the cards.

### AMA Linking with Ancillary Data

You can AMA link to an XDCAM or an MXF (SMPTE 436M) clip with ancillary data, the ancillary data appears in your bin. You can link to the ancillary data clip without an Avid input/output hardware, however, in order to view the ancillary data in a monitor, an Avid Nitris DX or Avid Mojo DX device is required.

For information about ancillary data and data tracks, see “Preserving HD Closed Captioning and Ancillary Data” on page 1234 and “Data Track Method” on page 1235.

### AMA Linking with Multichannel Audio

You can use the AMA Settings dialog box to define the audio track formats for the audio channels in your linked media, up to a maximum of 16 audio channels for the clips in your bins. This allows you to specify which source channels are treated as mono or multichannel audio tracks in your project, rather than having to modify the clips in your bin after you link to the AMA media.

The mappings affect all media clips created when you link to your source media. If you want to use different mixes for different master clips or different projects, create a custom AMA Settings template for each separate type of mix and then create your linked master clips.
Each stereo track requires two channels, but you can mix mono and stereo input channels for your linking operation as long as you do not exceed the maximum of 16 audio channels for each master clip.

To specify the multichannel audio mix for linked AMA clips:

1. In the Project window, click the Settings tab.
2. Double-click AMA.
   The AMA Settings dialog box appears.
   For information about the AMA Settings, see “AMA Settings” on page 46.
3. Click the Link Options tab.
   The Link Options tab lists any multichannel audio mappings in the current AMA Settings template.
4. Click Edit.
   The Set Multichannel Audio dialog box opens.
5. Click the format buttons to select one of the following audio track formats for each pair of source channels:

<table>
<thead>
<tr>
<th>Button</th>
<th>Track Format</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mono</td>
</tr>
<tr>
<td></td>
<td>Stereo</td>
</tr>
</tbody>
</table>

You must map source audio channels in mono or stereo pairs. For example, you cannot map A1 to a mono track and A2 and A3 to a stereo track. Instead, map A1 and A2 to mono tracks, and A3 and A4 to a stereo track. If the source media does not have an audio channel on A2, the Avid editing application ignores the channel.

6. Click OK to close the Set Multichannel Audio dialog box, and then click OK to close the AMA Settings dialog box.

The Track Formats column in the bin Text view displays the format for all multichannel audio tracks in a master clip.

To save a custom map of linked audio channels as a settings template:

1. Click the Settings tab in the Project window.

   The Settings list appears.

2. Click AMA.

3. Select Edit > Duplicate.

   A duplicate setting appears in the Settings list.

4. Name the setting by doing the following:

   a. Click the custom name column.

   b. Type a name.
The AMA Plug-in Log File

c. Press Enter (Windows) or Return (Macintosh).

The custom name column is the center column in the Project window. When you move the pointer over the custom name column, the pointer changes from a pointing finger to a text insertion bar.

You can select this new setting whenever you link clips with AMA.

The AMA Plug-in Log File

The Avid system creates an AMA plug-in log file when you link clips. The log file records errors and information about the clips. If you experience any problems while you link clips or if you receive an error message, check the AMA log file to get more information about the error (for example: a corrupt file or a bad filename). You can view the log file from the following location on your system:

- (Windows) drive:\Program Files\Avid\Media Composer\Avid FatalError Reports. The name of the log file is AMALoggerMM_DD_YY.log.
- (Macintosh) Volume/Users/Shared/AvidMediaComposer/Avid FatalError Reports. The name of the log file is AMALoggerMM_DD_YY.log.

Using Virtual Volumes

You can use a virtual volume to copy media from a card or disk. This lets you use the card or disk again. A virtual volume can be a folder on your desktop or a folder located on a server. However, the virtual volume folder should reside one level down from the root level in order for the system to display it as a virtual volume. The following are examples of virtual volumes:

- C:\Desktop\BPAV
- Z:\P2\Card 1
- Z:\GFPAK\n
When linking to AMA volumes, the system looks into folders up to two levels deeper. This is helpful when linking to AMA volumes that contain left and right stereoscopic files/folders.

With the AMA method, all drives and virtual volumes associated with your bin mount automatically. You cannot remove a volume while in AMA, however you can remove a virtual volume.

**To unmount a virtual volume:**

   
   The Unmount dialog box opens.
2. Select the virtual volume you want to remove.
3. Click OK. The system removes the virtual volume from your system and clips linked to this virtual volume appear offline. When you restart your Avid editing application, the system scans the system for virtual volumes and the clips appear online.

Virtual Volumes and AMA Bins

If you select Volume Name in the AMA Bin Settings tab, the system names the bin the same name as the virtual volume drive name. If you continue to use the same virtual volume to link other media through AMA, the system continues to place the linked media in the same bin. If you want to create a new bin for different types of media you link through AMA, you can either create a new virtual volume drive for each type of media (XDCAM, XDCAM EX, P2, GFCAM, etc.) or you can create a new bin every time you link to new media on a virtual volume.

To create a new bin on the same virtual volume:
1. Before you link your media through AMA, click the Settings tab in the Project window.
2. Double-click AMA.
3. Click the Bins tab.
4. Select “Create a new bin” and specify a new bin name.
5. Click OK.
6. Select File > AMA Link.
   The media appears in the newly created bin. Repeat these steps for each type of media.

Deleting Clips

You can delete master clips, but you cannot delete media files that reside on drives. Your Avid editing application treats files as read-only devices.

You can delete master clips and media files the same way you delete other master clips and media files. However, you might not be able to delete files that you moved rather than copied. If you cannot delete master clips and media files, first unlock the clips as described in the second procedure, and then delete them.

To delete files from cards/volumes:
1. Quit your Avid editing application.
2. On the desktop, navigate to the drive.
3. Select the files you want to delete and press the Delete key.

**To delete files on a local drive in your Avid editing application:**

1. In a bin, select the clips you want to delete.
2. (Option) Right-click and select Unlock Bin Selection.
3. Press the Delete key.
   
   The Delete dialog box opens.
4. Select Delete master clips and Delete associated media files.
5. Click OK.

You can also choose to AMA Link if you want to open the assets as Read-only in a classic bin.

---

**Using AMA Plug-Ins**

The following topics include high-level procedures of a typical workflow you might use when you edit with a particular media type and AMA Plug-Ins.

**Using XDCAM and XDCAM EX and XDCAM SR AMA Plug-Ins**

The Sony® XDCAM™ decks and camcorders use an optical disk to store recorded media. The XDCAM devices record media in high-resolution MPEG IMX™, DVCAM™, and XDCAM HD formats or corresponding low-resolution or compressed (proxy) media (MPEG-4). This lets you work with the compressed or low-resolution media in an off-line editing session and then later conform or link the compressed media to the corresponding high-resolution media. The HDCAM SR AMA plug-in supports MXF-wrapped SR Lite and SR SQ formats (422 YUV and 444 RGB) as transferred from HDCAM SR devices.

You can play XDCAM HD media to a Client monitor or output a digital cut as Best Performance (yellow/yellow) or Draft Quality (yellow/green). If you use Avid Nitris DX or Avid Mojo DX, you can play out the back of the HD-SDI.

The following steps describe a typical workflow for editing XDCAM, XDCAM EX or XDCAM SR clips with AMA.

> Do not mix AMA and traditional workflows. Either use AMA when you work with an XDCAM device or use the traditional import/batch import workflow.
Using AMA Plug-Ins

You should be aware of the following:

- Playback performance from an optical disk is very slow. To create a sequence with multiple effects or layered tracks, Avid suggests that you consolidate the media to a local drive, instead of working directly from the optical disk.
- Avid has turned off redrawing of waveforms in the Timeline when you link to XDCAM clips that reside on a disk. This allows for a faster linking process. When the media is consolidated, the waveforms redraw.
- When you link XDCAM clips from an optical disk, Avid recommends that you do not display the bin in Frame view or Script view due to performance issues.

A typical workflow is as follows:

1. Make sure the Sony XDCAM and XDCAM EX, or XDCAM SR AMA plug-in is installed on your system.
2. For XDCAM, install the appropriate Sony XDCAM drivers.
   You do not need drivers for XDCAM EX.
3. Insert the XDCAM disk or XDCAM EX card.
   The system links the XDCAM clips into a bin. The media itself remains on the disk. The clips point directly to the high-resolution media on the disk.
   For XDCAM clips from an optical disk, a progress bar appears to show you how much time is left to link the media.

   If you use multiple cards and you remove one of the cards, your media displays offline.

4. Use the master clips to edit the sequence.
5. (Option) Rename the clips to help organize your material.
6. You can either transfer your media to your hard drive and then transcode or consolidate your sequence or clips, or consolidate directly from the XDCAM disk.

   When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.

   Consolidating your media helps when you work with multiple cards. If you remove a card from the reader, consolidating lets you view your sequence with all the media online.

   Due to the design of the Nitris input/output hardware, playback of XDCAM or XDCAM EX media on an Avid Symphony using Nitris causes dropped frames. To allow for full performance playback, transcode the XDCAM media into DNxHD media to play the video on your Avid Symphony system with Avid Nitris input/output hardware.
For information on consolidating your sequence, see “Consolidating Media” on page 567. For information on transcoding your sequence, see “Using the Transcode Command” on page 573.

7. Remove the XDCAM disk or XDCAM EX card:
   - (Windows) Select Safely Remove Hardware icon in the taskbar and select Safely Remove XDCAM EX device name.
   - (Macintosh) Click the device icon on your desktop and drag it to the Trash.

Using XDCAM Multiple Resolution Clips with AMA

The XDCAM AMA plug-in allows you to link to low-resolution (proxy) or high-resolution audio or video media. The AMA multiple resolution feature supports specific XDCAM devices which include a /PROAV folder. For example, the Sony PDWU1 Professional Disc Drive Unit. See your Sony documentation for information on how to enable the /PROAV directory for your device.

Avid editing systems do not support XDCAM proxy audio.

The following steps describe a typical workflow for editing XDCAM multiple resolution clips with AMA.

Do not mix AMA and traditional workflows. Either use AMA when you work with an XDCAM device or use the traditional import/batch import workflow.

You should be aware of the following:

- Playback performance from an optical disk is very slow. To create a sequence with multiple effects or layered tracks, Avid suggests that you consolidate the media to a local drive, instead of working directly from the optical disk.
- Avid has turned off redrawing of waveforms in the Timeline when you link to XDCAM clips that reside on a disk. This allows for a faster linking process. When the media is consolidated, the waveforms redraw.
- When you link XDCAM clips from an optical disk, Avid recommends that you do not display the bin in Frame view or Script view due to performance issues.

A typical workflow is as follows:

1. Use Sony’s PDZ-1 software to associate your low-resolution clips with metadata to identify the clip in the Avid bin. This includes entering a User Disc ID in the Disc Properties window.

2. The Sony XDCAM and XDCAM EX AMA plug-in should be installed on your system.

3. Install the appropriate Sony XDCAM drivers.

4. In the Project window, click the Settings tab.
5. Double-click AMA.
   The AMA Settings dialog box appears.
6. Click the Quality tab.
7. Click the appropriate resolution for your video and audio in the AMA Link Preference section, and click OK.
8. Insert the XDCAM disk in the XDCAM device.
   For information on bin selection options, see “Linking Media with AMA” on page 93.
10. Select File > Link to AMA Volume.
   The Browse for Folder dialog box opens.
11. Navigate to the XDCAM clips, and then click OK.
   The clips appear in the bin or bins depending on the bin options you selected. A link icon appears next to the clips.
12. Edit the sequence.
13. Right-click the bin and select Modify AMA Resolutions to relink your low-resolution to high-resolution media.
14. To consolidate your media, see “Consolidating Multiple Resolution Media” on page 108.

   When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.

15. Click the Highest Quality for your video and audio and click OK.
   The highest quality clips appear in the bin along with the low resolution (most compressed) clips. A link icon appears next to the clips.
   If the system cannot find the corresponding low-resolution clip, it might be because you inserted the wrong XDCAM disk. If you insert the wrong disk, the system displays a message that informs you to insert the correct disk. If you used Sony’s PDZ-1 software and provided a disk name in the User Disc ID field, the system message displays the disk label name. If you did not use the PDZ-1 software, the system asks you to insert the disk containing the (low-resolution) clip selected in the bin.
16. Remove the XDCAM disk.

Spanned clips are clips that extend from one card to another. Avid supports working with spanned XDCAM EX clips in your Avid editing application.

For more information about spanned clips, see “Spanned Clips” on page 98.
Switching Between Multiple Resolution Media

Once you link to the low-resolution or high-resolution media and complete your edits, you can easily switch from low to high and high to low-resolution media. When you switch to a different resolution, the system replaces the clip in the bin with the new clip and resolution.

The steps below highlight switching from low-resolution to high-resolution media. You can also switch from high-resolution to low-resolution.

For XDCAM, if you use the Sony PDZ-1 software to assign a User Disc ID, the Avid editing system displays this information in a bin column and knows what disk name is associated with each clip.

To switch from low-resolution to high-resolution media:

1. Insert the disk in the device.
2. Select the low-resolution clips in the bin.
3. Right-click the bin and select Modify AMA Resolutions.
   The AMA Resolutions Quality dialog box appears.
4. Click the Highest Quality for your video (audio is always set to Highest Quality) and click OK.
   The highest quality clips replace the most compressed (low-resolution) clips in the bin. A link icon appears next to the clips.
   If the bin contains clips from multiple volumes, you will be prompted to insert another disk.

Consolidating Multiple Resolution Media

When you are ready to move your media to shared storage, you can link to your resolution and consolidate at the same time.
The steps below highlight consolidating high-resolution media. You can also consolidate low-resolution media.

For information on why you should consolidate, see “Consolidating Media” on page 567.

To consolidate high-resolution media:
1. In the Project window, click the Settings tab.
2. Double-click AMA.
   The AMA Settings dialog box appears.
   For information about the AMA Settings, see “AMA Settings” on page 46.
3. Click the Quality tab.
4. Click the appropriate resolution for your video in the Consolidate Preference section, and click OK.
   If a particular resolution is not available, it will be grayed out.
5. To consolidate the clip, follow the steps in “Using the Consolidate Command” on page 569.
   The resolutions you select in the Consolidate Preference area of the AMA Settings Quality tab displays in the Transcode/Consolidate dialog box when you consolidate or transcode.
Using the P2 AMA Plug-In

Panasonic’s P2 equipment records DV, DVCPRO, and DVCPRO 50 media on compact, solid-state memory cards (P2 cards). Avid editing applications support editing of media directly from these memory cards, without the need to capture. You can also write your sequence back to the P2 card. Panasonic P2 video and audio media is recorded in MXF format.

The following are recognized as P2 cards by your Avid editing application:

- Panasonic P2 cards in an attached reader or camera or in a laptop PC Card slot.
- Synthetic P2 cards. A complete copy of a P2 card copied to the root of a drive or mounted as a drive, for example, by mapping to a drive letter.

Each P2 card stores MXF files in two folders:

- (Windows) drive:\Contents\Audio
  (Macintosh) Macintosh HD/Contents/Audio
- (Windows) drive:\Contents\Video
  (Macintosh) Macintosh HD/Contents/Video

Examples of MXF audio and video files contained in the Audio and Video folders. Top: four audio tracks for a single clip. Bottom: the corresponding video track.
Panasonic P2 devices write individual MXF audio and video media files for each track of each clip. For example, a P2 clip that includes one track of video and four tracks of audio is stored on the P2 card as five individual media files. Within your Avid editing application the five media files are represented as a single clip with audio and video.

The following steps describe a typical workflow for editing P2 clips with AMA.

**Do not mix AMA and traditional workflows. Either use AMA when you work with a P2 device or use the traditional import/batch import workflow.**

**A typical workflow is as follows:**

1. Make sure the Panasonic P2 AMA plug-in is installed on your system.
2. Install the appropriate Panasonic P2 driver.
3. Mount one or more P2 cards (up to five). For information on mounting and naming P2 cards, see your Panasonic device documentation.
   The system links the P2 clips automatically into a bin.
4. Use the master clips to edit and output a sequence.
5. (Option) Rename the clips to organize your material.
6. Consolidate or transcode your sequence or clips.
   The media consolidates to the destination you set in the Media Creation dialog box.
   Consolidating your media helps when you work with multiple P2 cards. If a card is removed from the reader, consolidating lets you view your sequence with all the media online.

**When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.**

**When you transcode a sequence, the system automatically defaults to convert both audio and video. You cannot transcode video only with P2.**

**For information on consolidating your sequence, see “Consolidating Media” on page 567. For information on transcoding your sequence, see “Using the Transcode Command” on page 573.**

7. Remove the P2 card.
If you work in an Avid shared storage environment, you can share sequences that contain P2 clips in an Avid shared storage workspace. However, you can share P2 clips only if you transcode or consolidate them to a workspace.

- In an MXF workgroup, you can either consolidate or transcode P2 clips to a workspace. If you transcode, you must transcode P2 MXF files to another MXF resolution.
- In an OMF workgroup, you must transcode P2 clips to a workspace. You must transcode P2 MXF files to OMF files.

If you consolidate or transcode clips to an Avid shared storage workspace, it automatically checks all related metadata into the asset manager. This makes the clips accessible to other users.

For more information on workgroup support, see the Avid Interplay Help.

Some card slots of the P2 drive might require drive letters that have already been assigned to existing network drives. If your computer does not display all five card slots as drives, reassign the network drives or restart your system.

Spanned clips are clips that extend from one card to another. Avid supports working with spanned P2 clips in your Avid editing application.

For more information about spanned clips, see “Spanned Clips” on page 98.

### Using the AVCHD AMA Plug-In

AVCHD is a file-based format and does not use magnetic tape. Instead, video can be recorded onto DVD discs, hard disk drives, non-removable solid-state memory and removable flash memory cards.

Play performance might vary depending on the type of medium you use and the speed of our computer.

AVCHD media files are recorded in MTS format; the file contains both the video and audio. Audio can be either uncompressed PCM or Dolby® AC-3 format.

You must activate the Dolby AC-3 codec the first time you AMA link to an AVCHD clip. If you are connected to the Internet, activation is automatic. If you are not connected to the Internet, the system opens a dialog box and then the Avid License Control tool. Follow the on screen instructions to activate this feature.

The folder and file structure is dependent on the camera you use.

Most AVCHD cameras produce default file names starting with “00000.” Be aware that you could have multiple clips with the same file name across multiple media drives.
The following steps describe a typical workflow for editing AVCHD clips with AMA.

**A typical workflow is as follows:**

1. Install the AVCHD AMA plug-in on your system.
2. To link to an entire volume, attach the camera and insert a card, disc or drive.
   The system links the AVCHD clips automatically into a bin.

   *It is highly recommended for performance reasons, that you copy the entire media volume to an external HD drive if you plan on copying media from a card. You may have to use the File > AMA Link command if the files do not automatically link.*

3. To link to an individual AVCHD file, with the camera and card, disc or drive inserted, select File > AMA Link.
   The Open dialog box opens.
4. From the AMA Plugin Filter menu, select AVCHD.
5. Locate and select the .mts file(s) you want to link. Ctrl+click or Shift+click to select multiple files.
6. Click Open.
   The clips appear in the active bin. A link icon appears next to the clips.
7. Use the master clips to edit and output a sequence.
8. (Option) Rename the clips to organize your material.
9. Transcode your sequence or clips.

   *When you transcode a sequence, the system automatically defaults to convert both audio and video. You cannot transcode video only with AVCHD.*

   *For information on transcoding your sequence, see “Using the Transcode Command” on page 573.*

Spanned clips are clips that extend from one card, disc or drive to another. Avid supports working with spanned AVCHD clips in your Avid editing application.

For more information about spanned clips, see “Spanned Clips” on page 98.
Using the Canon XF AMA Plug-In

The Canon XF305 and Canon XF300 camera records MPEG-2 media onto compact flash cards. Through the Canon XF AMA plug-in and the MXF AMA plug-in, you can link to Canon MPEG-2 media through the AMA method. Canon XF video and audio media files record in MXF format.

You can edit directly from a flash card, without having to capture. You can link to a Canon XF flash card and reader attached to your system or copy a Canon XF flash card to the root of a drive.

Each card stores the video and audio files in:

- (Windows) drive:\CONTENTS\CLIPS
- (Macintosh) Macintosh HD/CONTENTS/CLIPS

AMA does not recognize clips if the folder names in the selected path contain double-byte characters (DBCS). AMA recognizes folders with the directory path that includes ASCII alphanumeric characters.

A typical workflow is as follows:

1. The Canon XF AMA plug-in and the MXF AMA plug-in should be installed on your system.
2. Mount the flash cards.
   The system links the Canon XF clips automatically into a bin.

If you use multiple flash cards and you remove one of the cards, your media displays offline.

3. Use the master clips to edit and output a sequence.
4. (Option) Rename the clips to organize your material.
5. Consolidate or transcode your sequence or clips.
   The media consolidates to the destination you set in the Media Creation dialog box.
   Consolidating your media helps when you work with multiple cards. If a card is removed from the reader, consolidating lets you view your sequence with all the media online.

When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.

For information on consolidating your sequence, see “Consolidating Media” on page 567. For information on transcoding your sequence, see “Using the Transcode Command” on page 573.
6. Remove the flash card.
Spanned clips are clips that extend from one card to another. Avid supports working with spanned Canon XF clips in your Avid editing application. For more information about spanned clips, see “Spanned Clips” on page 98.

Using the GFCAM AMA Plug-In

The Ikegami GFCAM HDS-V10 is a tapeless camera/recorder that uses flash memory instead of video tapes as a recording medium. GFCAM devices record MPEG-2 Long GOP media onto a GFPAK™, a removable high-speed storage medium. GFCAM is only available through the AMA method. GFCAM video and audio media files record in MXF format.

Each GFPAK stores the video MXF files in:
- (Windows) drive:\BINxxx\VIDEO
- (Macintosh) Macintosh HD/BINxxx/VIDEO

Each GFPAK stores the audio MXF files in:
- (Windows) drive:\BINxxx\AUDIO
- (Macintosh) Macintosh HD/BINxxx/AUDIO

The GFCAM video file directory stores MXF files regulated by SMPTE 390M (MXF OP-Atom) and SMPTE 381M (MXF mapping MPEG streams into MXF GC). If a video clip needs to split, such as under the FAT32 file system, the system creates multiple MXF files for that clip.

The GFCAM audio file directory stores MXF files regulated by SMPTE 382 (MXF mapping AES3 and BWF into the MXF GC). Each file has an AES channel that consists of two audio channels. For example, the system creates two MXF files from two AES channels (four audio channels). If an audio clip splits, the system creates multiple audio files for that clip.

GFCAM allows gapless recording over several GFPAKs, however, each GFPAK handles the contents as a separate clip. If you record across three GFPAKs, you create three separate clips. You can then edit those clips together into one continuous sequence.

1080p/23.98 pulldown and 720p/23.98 pulldown record at 59.94fps and are only compatible with 1080i/59.94 and 720p/59.94 projects.

1080p/29.97 records as PSF at 59.94fps and is only compatible with 1080i/59.94 projects.

1080p/25 and 720p/25 record as PSF at 50fps and are only compatible with 1080i/50 and 720p/50 projects.
A typical workflow is as follows:

1. Make sure the GFCAM AMA plug-in is installed on your system.
2. Insert the GFPAK.
   
   Your Avid editing system links the GFCAM clips automatically into a bin. The media itself remains on the disk. The clips point directly to the high-resolution media on the disk.

   If you use multiple GFPAKs and you remove one of the GFPAKs, your media displays offline.

3. Use the master clips to edit the sequence.
4. (Option) Rename the clips to organize your material.
5. Consolidate or transcode your sequence or clips.
   
   Consolidating your media helps when you work with multiple GFPAKs. If a GFPAK is unplugged, consolidating lets you view your sequence with all the media online.

   When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.

   When you transcode a sequence, the system automatically defaults to convert both audio and video. You cannot transcode video only with GFCAM.

6. Disconnect the GFPAK.

Working with Shot Marks and Check Marks with GFCAM Media

GFCAM products use Shot Marks and Check Marks to store metadata about media clips.

Shot Marks allow GFCAM cameras to mark events such as clip start points or audio clipping. Press the RET button on the GFCAM device while you record or playback to set a Shot Mark. For a description of Shot Marks, see your GFCAM documentation.

In the AMA method, Shot Marks are brought over automatically and appear as markers in your Avid editing application. There is no text associated with a Shot Mark, just a marked location (or a marker). For information about editing markers, see “Using Markers” on page 646.

A Check Mark flags a “good shot.” The AMA method translates this good shot clip with the word “true” in a new bin column named Check Mark. If there are no Check Marks associated with a clip, a Check Mark heading does not appear.
Using the RED AMA Plug-In

The RED ONE camera generates a 4K (or 2K - 4.5K) full resolution REDCODE™ RAW (.R3D) file. Media is stored on a REDFlash card or a RED drive. You can link to a specific R3D file on the volume or link to the entire volume. RED ONE cameras record metadata which displays in an Avid bin. The metadata includes: edge code, timecode, lens parameters, audio settings and any video image processing information.

Your Avid editing application supports RED R3D files as high quality HD media. Once you link the clips through AMA, you can change and fine-tune the clip color settings through the Source Settings dialog.

You cannot consolidate the RED media in your Avid editing application.

The RED Camera records a unique clip name and additional files that include the REDCODE RAW files and an optional QuickTime reference file placed in a clip folder (.RDC). The system names clips by Camera Letter + Reel Number + Month + Day + a two digit alphanumeric random number.

For example: A001_C002_0502A6.RDC

Each clip folder (.RMD) is at the root directory. In each of these folders is the .RDC folder which contains the video, audio, and metadata files:

- (Windows) drive:\camera+reel_date.RMD\camera+reel_clip_date+random number.RDC
- (Macintosh) Macintosh HD/camera+reel_date.RMD/camera+reel_clip_date+random number.RDC

Avid's RED workflow allows you to work with RSX, RLX, and RMD files to manage a clip's color. You have access to all the metadata and color values in the raw RED files as well as the above mentioned “look” files associated with this media. You may also make non-destructive, custom color adjustments to the R3D clip. These adjustments can be made at any stage of the process.

AMA detects folders named with RMD and RDC and files named .R3D.

Audio is included in the RED files, and will display as .wav files in the bin.

You cannot span media across multiple cards. Each clip is recorded as a separate clip, regardless of how many cards you use. There is a 2GB limit on a single master clip. As you record footage, once a 2GB file is captured, an R3D file is created (.001). The camera continues to record and the next 2GB (or less) of media creates another R3D file (.002) until you end recording. So, you can have several R3D files in one clip folder but they are all associated with one master clip.

When you link these files/folders through the AMA method, one master clip appears in your bin.
Using AMA Plug-Ins

A typical workflow is as follows:

1. Make sure the RED AMA plug-in is installed on your system.
2. Attach the RED drive or insert a REDFlash card.
   
   Your Avid editing system links the RED clips automatically into a bin. The media itself remains on the disk. The clips point directly to the high-resolution media on the disk. All metadata information displays as columns in the bin.

   *If you use multiple cards and you remove one of the cards, your media displays offline.*

3. Right-click the clip in the bin and select Source Settings.
   
   For detailed information to set clip parameters, see “Adjusting RED Source Settings” on page 119.

4. Use the master clips to edit the sequence.
5. (Option) Rename the clips to help you organize your material.
6. Choose the video quality from the Transcode & Consolidate tab of the Media Creation setting.
   
   For more information, see “Preparing your RED Clip for Transcode, Mixdown, or Render” on page 118.

7. Transcode your sequence or clips to an HD or SD resolution.
   
   If you need to output to a resolution higher than HD, then export an AFE of your sequence for the conform process on an Avid DS. If your high-resolution media is on a shared storage device and Avid DS has access to the device, Avid DS automatically relinks to the RED files.

8. Remove the RED drive or card.

   For information on preparing your RED clip for transcode, mixdown, or renders, see “Preparing your RED Clip for Transcode, Mixdown, or Render” on page 118

**Preparing your RED Clip for Transcode, Mixdown, or Render**

If you want to take a RED clip and offline it to another application, you can create a different resolution RED file, depending on your requirements. This changes the speed and quality of the clip, which could affect the playback performance. The higher the video quality the slower the process (transcode, mixdown, render). The lower the video quality the faster the process. Before you transcode, mixdown or render your clip or sequence, set the appropriate quality in the Media Creation dialog box.

   *If you apply any Reformat options (stretch, letterbox, etc.) to your clip, when you perform a transcode, the reformatting options will apply.*
To prepare your RED clip for transcoding, mixdown or rendering:

1. Before you transcode, mixdown or render, select Tools > Media Creation.
2. Click the Mixdown & Transcode tab or click the Render tab.
3. Select the playback quality from the R3D Source Quality (Debayer) menu.
   - Full
   - Half (Best Quality)
   - Half (Good Quality)
   - Quarter
   - Eighth
   - Sixteenth
4. Click OK.
5. Transcode, mixdown or render your clip or sequence as required.

Adjusting RED Source Settings

When you link to R3D (RED) files, the Avid editing system reads each REDCODE RAW file directly. You can then change the clip’s color values: color balance, exposure, and contrast in the Source Settings window. This color value information is encoded with the R3D file through an RLX, RSX or RMD file. These files hold the camera’s original color values of your clip.

The RLX, RSX or RMD files might be created if you set the color values outside of the Avid editing application. These files can be loaded and applied to the associated RED clip through the Source Settings window.

When a RED clip displays in the bin, the system displays the metadata columns of the clip’s color values. For example: Color Space, Gamma Space, Kelvin, Tint. You can export this information to ALE (Avid Log Exchange) and XML (through Avid FilmScribe) for downstream use in your workflow.

The AMA Source Settings window also has various color spaces to choose from. You can set up different color options (or presets) in each of these color spaces and then apply their color values to multiple clips.

To change the RED source settings:

1. Link the RED clip through the AMA Link option.
2. Right-click the RED clip in the bin and select Set Source Settings.
   - The Source Settings dialog box opens. The clip displays in the video area.
You can choose from the Settings menu to select a camera metadata setting or an RSX, RLX or RMD setting (template), or adjust your own custom parameters. This procedure details the custom parameters.

3. Drag the video slider to the frame you want to view.

The new frame displays and the histogram updates.

The histogram is a tool that helps you more precisely adjust Source Settings. For more information about the histogram, see “Understanding the Source Settings Histogram” in the Avid editing Help.
4. Set the appropriate options, you can select from a menu, drag the sliders, enter values or click the eyedropper:

<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color Space</strong></td>
<td>Choose from:&lt;br&gt;- Camera RGB: as close to RAW&lt;br&gt;- REC.709: SMPTE standard color space for HD&lt;br&gt;- REDcolor (default): newest, more accurate color science from RED&lt;br&gt;- REDcolor2: better skin tones and color from RED&lt;br&gt;- REDcolor3: more improvements from RED&lt;br&gt;- REDSpace: based on the camera’s RGB but more saturated</td>
</tr>
<tr>
<td><strong>Gamma Curve</strong></td>
<td>Lets you override the gamma curve. Choose from:&lt;br&gt;- REC.709: a REC.709 gamma curve with a linear portion at black and a gamma at 2.2 curve&lt;br&gt;- REDLog: maps the 12-bit sensor data on to a 10-bit curve with minimal loss&lt;br&gt;- REDLogFilm: a way of containing a large dynamic range in a video file. Needs to be viewed through a LUT to convert it for viewing on a monitor.&lt;br&gt;- REDSpace: based on REC.709 but with more contrast&lt;br&gt;- REDGamma (default): gamma curve from RED with a smoother highlight rolloff&lt;br&gt;- REDGamma2&lt;br&gt;- REDGamma3</td>
</tr>
<tr>
<td><strong>White Balance</strong></td>
<td>Adjusts the color temperature of your image in one click. Use the eyedropper icon and then click a known white area in your RED footage to achieve the correct light or neutral balance. This option is equivalent to adjusting the Kelvin and Tint options. When you use the White Balance option, the system automatically adjusts Kelvin and Tint. It is recommended you adjust White Balance first before performing any other adjustments to the image for best quality. This change adjusts the entire clip and updates the histogram.</td>
</tr>
<tr>
<td><strong>Kelvin</strong></td>
<td>Adjusts the RGB color to compensate for red - blue tinting of the scene at different color temperatures of the ambient light while you shoot. Common values are 3200 (tungsten) and 5600 (daylight). Click and drag the slider from 1700 to 9400. Default is 5600.</td>
</tr>
<tr>
<td><strong>Tint</strong></td>
<td>Adjusts the RGB color to compensate for yellow - green tinting of the scene at different color temperatures of the ambient light while you shoot. This is valuable when the ambient light source contains a significant amount of yellow or green, such as fluorescent. Click and drag the slider from -100 to 100. Default is 0.00.</td>
</tr>
<tr>
<td><strong>ISO</strong></td>
<td>Allows the ISO level to change from 50 to 2000. Default is 320.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FLUT™</td>
<td>The latest color science developed by RED. Allows you to balance your mid-grays in the center of the histogram without pushing highlight details over the edge.</td>
</tr>
<tr>
<td>Shadow</td>
<td>Adjusts the overall black level of the image without affecting the white level. Click and drag the slider from 0.00 to 1.00. Default is 0.00.</td>
</tr>
<tr>
<td>DRX</td>
<td>Lets you recover potentially lost dynamic range by extending and balancing highlights, taking into account the rendering intent of the desired Kelvin and Tint white balance. Click and drag the slider from 0.00 to 1.00. Default is 0.00.</td>
</tr>
<tr>
<td>Debayer Detail</td>
<td>Choose from High (default), Medium, or Low.</td>
</tr>
<tr>
<td>Chroma Denoise</td>
<td>Choose from Off (default), Minimum, Milder, Mild, Strong, or Maximum.</td>
</tr>
<tr>
<td>OLPF</td>
<td>Controls the optical low-pass filter. Choose from Off (default), Low, Medium, or High.</td>
</tr>
<tr>
<td>Exposure</td>
<td>Allows adjustment to the clip exposure. Click and drag the slider from -7.00 to 7.00. Default is 0.00.</td>
</tr>
<tr>
<td>Brightness</td>
<td>Adjusts the overall brightness of the image. Lifts blacks without affecting the white level. Click and drag the slider from -10.00 to 10.00. Default is 0.00.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Adjusts the tonal range of the image, which usually improves sharpness and detail. When you increase the Contrast, it increases tonal separation between adjacent gray levels but decreases the total number of discreet gray levels in the image. Click and drag the slider from -1.00 to 1.00. Default is 0.00.</td>
</tr>
<tr>
<td>Saturation</td>
<td>Affects the intensity of the red, green and blue channels. As the value increases color saturation increases. As the value decreases, so does the color decrease. If the value is set to high, colors might clip. If the level is set to 0.00, a monochromatic image with only gray tones appear. Click and drag the slider from 0.00 to 4.00. Default is 1.00</td>
</tr>
<tr>
<td>Red</td>
<td>Increases or decreases the camera’s sensitivity to red light by amplifying the R channel digital video signal received from the sensor. A 0 (zero) no Red is visible, the image has a strong cyan cast. Click and drag the slider from 0.00 to 10.00. Default is 1.00</td>
</tr>
</tbody>
</table>
Using AMA Plug-Ins

5. Click Apply.

The changes apply to your clip. You can continue to make additional changes.

If the clip is in the Source viewer, the changes are reflected in the Source viewer and in the Client monitor (if you have one attached).

If you click Cancel after you click Apply, the Set Source Settings window closes with the changes you made.

6. Click OK to save your change and close the window.

The system updates the bin column metadata with the new parameters.

If you make changes in the Source Settings window and then relink the clip through AMA again, you still keep all the parameters that you set.

Using RED Source Settings

Source Settings lets you choose from a selection of preset templates or you can create your own look. Each source setting has its own color values associated with it. There are a few different ways to obtain source settings:

• Camera and default source settings are included with the RED AMA plugin
• Link a RED clip from RED Alert! (imports the RSX source setting)
• Load a source setting onto your system (for example, an RLX, RSX, or RMD)
• Create a custom source setting

You cannot change the default RSX and RLX source settings, these are predefined. Once you make a change to a parameter, the setting becomes a Custom setting. At this time, you can only have one Custom setting.
You can load multiple RSX and RLX source settings. As you link a RED clip from RED Alert! (RSX) or load an RLX file, the setting appears in the Source Settings menu.

Source Settings are helpful when you want to apply one setting to multiple clips in your bin.

Different subclips from the same master clip can have different source settings.

When you edit a clip into a sequence, the material you edit in uses the clip’s current attribute values or RED source settings. If you change the RED source settings at a later point in your workflow, the sequence does not automatically adjust for the change. If you want the sequence to use the RED source settings for clips that you have changed since you edited, you must refresh the sequence. For procedures on how to refresh your sequence, see “Refreshing Sequences to Use Current Clip Attributes” on page 731.

### Applying a RED Source Setting

**To apply a source setting to a RED clip:**

1. Right-click a RED clip in the bin (or Shift-click multiple clips), then choose Set Source Settings.

   The Set Source Settings window opens and your clip displays in the viewer.

2. Select a setting (template) from the Source Settings menu.

   Source Settings vary depending on the files or templates loaded on your system.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Origin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera Metadata Settings</td>
<td>Default</td>
</tr>
<tr>
<td>Default Settings</td>
<td>Default</td>
</tr>
<tr>
<td>Grade (RSX) Settings</td>
<td>RED Alert!</td>
</tr>
<tr>
<td>filename RLX Setting</td>
<td>RED Alert!</td>
</tr>
<tr>
<td>Grade (RMD) Setting</td>
<td>REDCINE-X</td>
</tr>
<tr>
<td>Custom</td>
<td>User created in Avid</td>
</tr>
</tbody>
</table>

3. Click Apply.

   The settings apply to the clip and if the clip is loaded in the Timeline, the video updates and displays in a Client monitor (if one is attached) and the Source monitor.

4. Click OK to save your settings and close the window.

   The system updates the bin column RED metadata with the parameters.
If you make additional changes after you select a setting, the system creates a Custom setting and Custom appears in the Settings list. You cannot make changes to a system generated setting, however you can use a system setting and make changes to create your own Custom setting.

**To import additional source settings:**
1. From the Source Settings window, click the Load button.
   The Load External Settings window opens.
2. Browse to the Settings file.
3. Change the filter to display RSX, RLX or RMD files.
4. Select your setting and click OK.
   The new source setting appears in the Source Settings menu, and is immediately applied to the clip.

**Using the QuickTime AMA Plug-In**

There are a few guidelines you should follow when you link QuickTime files through AMA.

To link QuickTime media through the AMA method, you first need to create a QuickTime movie from a third-party application or through the Avid editing system. The third-party applications that supports creating a QuickTime movie include Adobe AfterEffects® and Final Cut Pro. This is done through the QuickTime Export dialog box which uses the Avid QuickTime Codecs. These codecs automatically install on your Avid editing system. At this time, Avid supports the Same as Source and Custom export settings options when you export with the Avid QuickTime codecs. This process creates an Avid compressed QuickTime media file, with a .mov extension. AMA only detects and links to Avid compressed QuickTime media.

*For information about exporting a QuickTime movie, see “Exporting QuickTime Movies” on page 1164.*

QuickTime files use the .mov file name extension. After you link a QuickTime file through AMA, the file drops the .mov file name extension. QuickTime media is linked at the data rate at which it was recorded.

**A QuickTime AMA workflow is as follows:**
1. Create a QuickTime movie with a supported codec in an application such as Adobe AfterEffects or Apple’s Final Cut Pro.
   Avid supports the Same as Source and Custom export settings options when you export with Avid QuickTime codec.

*See Adobe and Apple documentation for information on how to create a QuickTime movie.*
2. Move the created .mov file onto your Avid editing system.

3. Open a bin.
   If there is no active bin, a dialog box appears asking you to select a bin.

4. Select File > AMA Link.
   You can also right-click a bin and select AMA Link.

   To link to multiple QuickTime files, use the File > Link to AMA Volume(s) option and select the folder that stores all the QuickTime files.

   For information about AMA, see “The Avid Media Access (AMA) Workflow” on page 79.

   The Open dialog box opens.

5. From the AMA Plugin Filter menu, select QuickTime.

6. Locate and select the .mov file(s) you want to link. Ctrl+click or Shift+click to select multiple files.

7. Click Open.
   The clips appear in the active bin. A link icon appears next to the clips.
   If any of the movies you linked to were QuickTime with Alpha channel files, they appear in your bin as a Matte Key effect. The Alpha Channel options in the Import Settings Image tab apply to the QuickTime AMA linked file. Therefore, the QuickTime file will appear in the bin as a master clip if the Ignore option is set or will appear inverted or not inverted depending on the selected options.

8. Use the linked clips to edit your sequence.

9. If you need to change the QuickTime clip in After Effects or FCP, open the existing file in After Effects or FCP and make the change.
   If you change the number of tracks, change the duration of the clip or change the clips file name, when you relink through AMA, the system creates a new clip and will not overwrite or replace the existing clip in the bin.
   If you change the number of tracks, the duration, or edit rate, but not the file name, any clips linked to the sequence will unlink and the clips display Media Offline.

   If you change the file name or the location of the clip, you can Relink to AMA files. For more information, see “Relinking to AMA-Linked QuickTime Files” on page 97.

10. From your Avid editing application, select Clear Monitor from the Clip Name menu above the monitors.
    This clears the monitors and Timeline of any old clips.
11. Render or export the newly changed QuickTime movie out of AfterEffects or FCP to the same folder location as the original file. Accept all overwrite prompts. Once the changed QuickTime movie is exported or rendered, refocus or open (if FCP or AfterEffects are on the same system) your Avid editing application.

The updated clip appears in your bin (and sequence) and replaces the old clip. If the clip is in the Source or Record monitor, it also will update.

12. Continue to edit your sequence or consolidate or transcode your sequence or clip.

- When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.

- For information on consolidating your sequence, see “Consolidating Media” on page 567. For information on transcoding your sequence, see “Using the Transcode Command” on page 573.

**Adjusting QuickTime Source Settings**

You can change the dynamic range of a linked AMA QuickTime movie from 601/709 video range (16-235) to RGB range (0-255) or from RGB range (0-255) to 601/709 video range (16-235). This setting is only supported with QuickTime movies that were created with a non-Avid codec, including ProRes, H.264 and Animation.

When a QuickTime clip displays in the bin, the system displays the metadata columns of the clip’s color values.

**To change the QuickTime source settings:**

1. Link the QuickTime clip through the File > Link to AMA File option or to link to multiple QuickTime files, use the File > Link to AMA Volume(s) option.

2. Right-click the QuickTime clip in the bin and select Set Source Settings.

- If your QuickTime movie was created with an Avid codec, the Set Source Settings option will not be available.

The Source Settings dialog box opens. The clip displays in the video area.
3. Drag the video slider to the frame you want to view.
   The new frame displays and the histogram updates.
   The histogram is a tool that helps you more precisely adjust Source Settings. For more information about the histogram, see “Understanding the QuickTime Source Settings Histogram” in the Avid editing Help.

4. Set the appropriate options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td>Default</td>
</tr>
<tr>
<td>Field Ordering</td>
<td>Default</td>
</tr>
<tr>
<td></td>
<td>Progressive: The image is interpreted as a progressive image.</td>
</tr>
<tr>
<td></td>
<td>Interlaced - Odd (upper field first) ordered: Adjusts the clip so that the</td>
</tr>
<tr>
<td>Field Layout</td>
<td>top field is played before the lower field.</td>
</tr>
<tr>
<td></td>
<td>Interlaced - Even (lower field first): Adjusts the clip so that the lower</td>
</tr>
<tr>
<td>(Available when Field</td>
<td>field is played before the top field.</td>
</tr>
<tr>
<td>Ordering &gt; Interlaced</td>
<td>is selected)</td>
</tr>
<tr>
<td></td>
<td>Merged (default): Alternates field information.</td>
</tr>
<tr>
<td></td>
<td>Split: Based on the field ordering selection (Interlaced Odd or Interlaced</td>
</tr>
<tr>
<td></td>
<td>Even), fields will be split into one over the other. For example, all odd</td>
</tr>
<tr>
<td></td>
<td>fields are over all even fields.</td>
</tr>
</tbody>
</table>
Using AMA Plug-Ins

5. Click Apply.

The changes apply to your clip. You can continue to make additional changes.

If the clip is in the Source viewer, the changes are reflected in the Source viewer and in the Client monitor (if you have one attached).

If you click Cancel after you click Apply, the Set Source Settings window closes with the changes you made.

6. Click OK to save your change and close the window.

The system updates the bin column metadata with the new parameters.

If you make changes in the Source Settings window and then relink the clip through AMA again, you still keep all the parameters that you set.

Applying a QuickTime Source Setting

Source Settings lets you choose from a Custom of Default setting. Each source setting has its own color values associated with it.

To apply a source setting to a QuickTime clip:

1. Right-click a QuickTime clip in the bin (or Shift-click multiple clips), then choose Set Source Settings.

The Set Source Settings window opens and your clip displays in the viewer.

2. Select a setting from the Source Settings menu.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Origin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Settings</td>
<td>Default</td>
</tr>
<tr>
<td>Custom</td>
<td>User created in Avid</td>
</tr>
</tbody>
</table>

3. Click Apply.
The settings apply to the clip and if the clip is loaded in the Timeline, the video updates and displays in a Client monitor (if one is attached) and the Source monitor.

4. Click OK to save your settings and close the window.

The system updates the bin column metadata with the parameters.

If you make additional changes after you select a setting, the system creates a Custom setting and Custom appears in the Settings list. You cannot make changes to a system generated setting, however you can use a system setting and make changes to create your own Custom setting.

*The Load button does not apply to QuickTime media.*

**Understanding the QuickTime Source Settings Histogram**

The histogram in the Source Settings window helps you visualize the distribution of color values in an image. You can use the histogram to adjust the Source Settings of your AMA media more precisely while avoiding clipping and color imbalance.

![Example of a Source Settings histogram. The histogram plots color values on the horizontal axis and the percentage or proportional number of pixels on the vertical axis. The vertical lines represent the black point (left) and the white point (right), so the area between them is the safe color range.](image)

The histogram plots color values that can be represented by the image bit-depth on the horizontal axis. Therefore, the width of the histogram is the same as the width of the image. The histogram plots the percentage, or proportional number of pixels in the image, with each particular color value on the vertical axis. The vertical axis is scaled according to the height of the maximum value in the plot. Whenever the histogram changes, the vertical axis rescales according to the new maximum.
Pixels with color values that are out of range are grouped into either the maximum or minimum color values on the plot. Spikes in either the highest or lowest color values might indicate loss of color information due to clipping.

Using the MXF AMA Plug-In

Material Exchange Format (MXF) is a wrapper or container format which encapsulates media and rich production metadata into a single file, which is useful for media storage and exchange. It is an open technology that can is implemented by different manufacturers.

MXF is designed to be flexible enough for use in all stages of content creation, from acquisition, to authoring, to distribution. The primary benefit of MXF is that it provides greater workflow efficiency by preserving useful metadata as media files make their way through the content creation process. The MXF format is independent of the type of content that it contains, so an MXF file can contain video and/or audio at any resolution or compression. In many instances MXF files encapsulate media which is already formatted to one of the existing industry standards.

You can select the MXF format when you capture, link, create titles, or render effects. See “Media Creation Settings” on page 125.

The MXF AMA plug-in is automatically installed when you install your editing application.

A typical workflow is as follows:

1. Create a supported MXF file (create a supported MXF file from your third party application, for example: Rhozet or Omneon).
2. Move the .mxf file onto your Avid editing system.
3. Select File > AMA Link.
   You can also right-click a bin and select AMA Link.
   The Open dialog box opens.
4. From the AMA Plugin Filter menu, select MXF.
5. Select the file(s) you want to link. Ctrl+click or Shift+click to select multiple files.
6. Click Open.
   The MXF clips appear in the active bin. A link icon appears next to the clips.
   If the system cannot link a file, an error message displays informing you to open the Console window for more information about the file(s) in error.
   If you move the clip from the original drive to another drive on your system, the clip displays as offline in your bin.
If you move a source file from one location to another and then back to the original location, you might need to refresh the bin to redisplay the clip. Close and reopen the bin to refresh the bin.

7. Use the linked clips to edit your sequence.
8. (Option) Rename the clips to help organize your material.
9. Consolidate or transcode your sequence or clips.

The media consolidates to the destination you set in the Media Creation dialog box.

When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.

Workflow for Editing Clips with Ancillary Data and AMA

The following steps describe a typical workflow for editing XDCAM or MXF clips with ancillary data and AMA.

Do not mix AMA and traditional workflows. Either use AMA or use the traditional import/batch import workflow.

You should be aware of the following:

- You can link to the ancillary data clip without an Avid input/output hardware, however, in order to view the ancillary data in a monitor, an Avid Nitris DX or Avid Mojo DX device is required.
- If you consolidate the XDCAM or MXF clip or the sequence that contains the XDCAM or MXF clip with ancillary data, the ancillary data track stays with the consolidated clip or sequence. In addition, the Ancillary Data bin column populates with the DID and SDID numbers once you consolidate or transcode the clip with the ancillary data.

A typical workflow is as follows:

1. The Sony XDCAM or MXF AMA plug-in should be installed on your system.
2. For XDCAM, install the appropriate Sony XDCAM drivers.
3. For an XDCAM clip with ancillary data, insert the XDCAM disk.

The system links the XDCAM clip with ancillary data into a bin. The media itself remains on the disk. The clips point directly to the media on the disk.

Ancillary data is only supported with high resolution XDCAM clips. A proxy clip does not contain a data track, however once you relink to the high resolution XDCAM clip, the data track comes online.

If you use multiple cards and you remove one of the cards, your media displays offline.
4. For an MXF clip with ancillary data, select File > Link to AMA File(s).
   The Select file(s) for AMA linking dialog box opens.
5. From the AMA Plugin Filter menu, select MXF.
6. Select the file(s) you want to link. Ctrl+click or Shift+click to select multiple files.
   The MXF clip appears in the bin along with a new Ancillary Data bin column.

For information about AMA, see “The Avid Media Access (AMA) Workflow” on page 79.

7. Use the master clips to edit the sequence.
   When you load the clip into a sequence, a Data track appears which contains the ancillary data.
8. You can then transcode or consolidate your sequence or clips.

When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.

   When you consolidate the XDCAM or MXF clip or the sequence that contains the XDCAM or MXF clip with ancillary data, the ancillary data track stays with the consolidated clip or sequence.

For information on consolidating your sequence, see “Consolidating Media” on page 567. For information on transcoding your sequence, see “Using the Transcode Command” on page 573.

Understanding the Source Settings Histogram

The histogram in the Source Settings window helps you visualize the distribution of color values in an image. You can use the histogram to adjust the Source Settings of your AMA media more precisely while avoiding clipping and color imbalance.
Understanding the Source Settings Histogram

Example of a Source Settings histogram. The histogram plots color values on the horizontal axis and the percentage or proportional number of pixels on the vertical axis. The vertical lines represent the black point (left) and the white point (right), so the area between them is the safe color range.

The histogram plots color values that can be represented by the image bit-depth on the horizontal axis. Therefore, the width of the histogram is the same as the width of the image. The histogram plots the percentage, or proportional number of pixels in the image, with each particular color value on the vertical axis. The vertical axis is scaled according to the height of the maximum value in the plot. Whenever the histogram changes, the vertical axis rescales according to the new maximum.

Pixels with color values that are out of range are grouped into either the maximum or minimum color values on the plot. Spikes in either the highest or lowest color values might indicate loss of color information due to clipping.

Your Avid editing application draws separate histograms for the red, green, and blue color components. The histograms for each color stack on top of one another, with the fill color changing appropriately to indicate overlap. The following illustration shows the colors produced by overlap.
You can adjust the Source Settings Histogram in two ways. You can toggle drawing a histogram for an individual color, and you can zoom the vertical axis.

**To adjust the Source Settings Histogram:**
- Right-click anywhere inside the histogram graph, and then select one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Enables or disables the histogram display for the selected color. A check mark indicates that the histogram for that particular color displays.</td>
</tr>
<tr>
<td>Green</td>
<td></td>
</tr>
<tr>
<td>Blue</td>
<td></td>
</tr>
<tr>
<td>Zoom In</td>
<td>Zooms in on the lower half of the vertical axis. Changes the scaling of the vertical axis so that the height is half that of the maximum value in the plot. You can zoom in indefinitely to display, for example, 1/4, 1/8, or 1/16 of the maximum value.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Zooms out of the vertical axis by a factor of two. Changes the scaling of the vertical axis to be twice that of the maximum value in the plot. You can zoom out indefinitely to display, for example, 4, 8, or 16 times the height of the maximum value.</td>
</tr>
</tbody>
</table>
Working with Export Volumes

The Avid editing application supports the creation of AS-02 Export Volumes. AS-02 is a specification for grouping multiple versions of program content into one single bundle. These bundles provide an efficient approach for working in a file-based environment.

For example, if you have a sequence with an English audio mix and a sequence with the same video but with a Spanish audio mix, creating an AS-02 Export Volume allows you to have all the program elements contained in a bundle without redundancy. The same video essence file can be the source for both the English and the Spanish versions. This is useful if you want to save time on export and reduce used disk space.

The basic workflow is to create a new Export Volume Bin, copy the sequence or sequences you want to the Volume Bin, commit the assets in the Export Volume Bin, and then archive the AS-02 bundle folder. You can also link to an existing AS-02 bundle.

The bundle folder structure is shown below. This is for reference only. These elements will be automatically created for you when you commit an Export Volume Bin.

- The Asset.mxf file is the sequence (version).
- The Manifest.xml file lists the creator information, creation date, version information and a list of all the files and folders in the bundle.
- The Shim.xml file is used as a template or settings file that constrains the rules for a specific facility.
• The *Media* folder contains all the media files included in the bundle.
• The *Extra* folder contains a copy of the unflattened sequence (AAF composition only). The Extra folder can also contain any other files you want to keep with the bundle, such as scripts, graphics, etc.

### Creating an Export Volume

You can create an export volume to place all program elements into a bundle.

**To create a new export volume:**

   
   The Export Volume dialog box opens.
2. Select a Volume Type, for example AS-02.
3. Click Set to select the path where you want the Export Volume to reside.
4. Enter a name for the volume.
5. Click Set to select the path to the shim template you want to use.
   - AS-02 supports J2K, Uncompressed 10b RGB, DNxHD, AVC1, IMX and
     Uncompressed 8b for SD.
   - All DNxHD templates are tuned to the DNxHD 220x family. That means depending on
     the project type, selecting a DNxHD template will export to a DNxHD 10b codec.
   - AS-02 Shim templates for all supported resolutions are located in the Supporting Files
     folder.
   - You can choose any one of these templates depending on the desired output
     codec/format.
   - You can also create a folder named Default at the root of the AS-02 Templates folder
     where you can place custom templates. For example, you can duplicate the
     AS-02_Shim_DNxHD_1080i_59.94.xml found in the DNxHD folder, modify it (to a
     different audio sample rate or DNxHD resolution) and place the duplicate in the Default
     folder. This duplicated template will now be the default template for 1080i59 projects.
   - DNxHD resolutions are supported except DNxHD 100 and DNxHD 36.
6. Click OK.
   The Export Volume bin opens.
Moving Assets to an Export Volume

You can move the desired assets to the Export Volume.

**To move assets to the Export Volume:**

1. Open the bin that contains the sequence or sequences you want to write to the Export Volume.
2. Select and drag the sequence(s) to the Export Volume.
   A copy of the sequence(s) appears in the Export Volume.
You can only drag sequences to an AS-02 Export Volume Bin. If you try to drag master clips, effects, titles, etc, you will receive a message indicating that some assets that you selected could not be dragged to the Volume Bin. If you receive this message, open the Console Tool to see the list of items that were not written.

Committing Assets to an Export Volume

Once you commit the assets, the sequence is flattened to the OP1b format, the video is encoded to the J2K codec and audio saved as PCM.

To commit the assets to the Export Volume:

1. Open the Export Volume that contains the sequence(s) to commit.
2. Click the Commit button to commit the assets to the AS-02 bundle.

The sequence along with its associated media files populate the Export Volume.

Note the Media Status column indicates the committed status of each asset in the volume. Green indicates the asset is committed. Yellow indicates the asset is not committed. Red indicates the asset is offline.
Working with Export Volumes

Once the assets are committed, the following are written to the bundle folder:

- The sequence (version)
- The essence files
- The manifest (a file listing the creation date, creator, version information and a list of all the files and folders in the bundle.)
- The shim file (used as a template or settings file that constrains the rules for the specific facility)
- An AAF copy of the unflattened sequences(s) in the Extras folder

Archiving the AS-02 Bundle

Once you have committed the assets to the Export Volume, you can archive the AS-02 bundle.

To archive the Assets Folder.
1. Locate the AS-02 bundle folder by accessing the path you set in step 4 of Creating an Export Volume.
2. Copy the AS-02 bundle folder to your archive server.

Linking to an existing AS-02 Bundle

You can open an existing AS-02 bundle.
To link to an existing AS-02 Volume:
1. Select File > Link to Volume for Export.
2. Select the folder where the AS-02 bundle resides.
3. Click OK.
4. A new volume bin opens with the AS-02 assets.
   You can also choose to Link to AMA Volume if you want to open the assets as Read-only in a classic bin.

AS-11 Support

The Avid editing application supports the Advanced Media Workflow Association (AMWA) AS-11 specification. This specification is used in broadcast environments. The specification defines a set of rules that constrain the specification. AS-11 is an OP1A MXF file format for the delivery of finished programming. This specification requires program segment markers. Program segmentation defines specific regions of a show, for example a segment marker for the A-block, B-block and C-block. See “Adding Spanned Markers While Editing” on page 651 to apply these markers before you export your sequence.

To export a sequence as AS-11:
1. Select the sequence you want to export as AS-11.
2. Click File > AMA File Export, or right click the sequence and select AMA File Export.
   The AMA File Export dialog opens.

3. Select File Type AS-11.
4. (Option) Select the Use Marks or Use Enabled Tracks option.
When you select Use Marks, your Avid editing application uses current IN and OUT points in the selected clip or sequence to determine starting and ending frames for the export. To export the entire clip or sequence, deselect this option or mark the entire clip or sequence.

When you select Use Enabled Tracks, your Avid editing application exports the tracks that are enabled in the Timeline. To export all the tracks in the sequence, deselect this option.

5. Click the Directory Set button to and browse to the location where you want the AS-11 file saved.
6. Click Select Folder.
7. Select the Shim Set button to locate the Shim file you want associated with the export and click Open. Avid provides shims in the following location:
   - (Windows) Program Files/Avid/EditingApplicationName/SupportingFiles
   - (Macintosh) MacintoshHD/Applications/EditingApplicationName/SupportingFiles

   The Descriptive Metadata populates in the window depending upon the shim you selected.
8. Enter the specific program information in the Descriptive Metadata fields.
   This is the descriptive data stored in the AS-11 export that describes Essence data. For example, the language, series title, program title, episode title, etc.
9. Click Save.
   The AS-11 file is exported to the selected directory.

When you perform an AMA link to the AS-11 sequence, the spanned markers are represented in the source Timeline and all the descriptive metadata appears in the Bin columns.